About This Document
This manual is intended for administrators and users of the AXIS 240Q Video Server, and is applicable for firmware release 4.40. It includes instructions for using and managing the AXIS 240Q on your network. Previous experience of networking will be of use when installing and using this product. Some knowledge of UNIX or Linux-based systems would also be beneficial, for developing shell scripts and applications. Later versions of this document will be posted to the Axis Website, as required. See also the product’s online help, available via the Web-based interface.

Safety Notices Used In This Manual
Caution! - Indicates a potential hazard that can damage the product.
Important! - Indicates a hazard that can seriously impair operation.
Do not proceed beyond any of the above notices until you have fully understood the implications.

Intellectual Property Rights
Axis AB has intellectual property rights relating to technology embodied in the product described in this document. In particular, and without limitation, these intellectual property rights may include one or more of the patents listed at http://www.axis.com/patent.htm and one or more additional patents or pending patent applications in the US and other countries.
This product contains licensed third-party software. See the menu item “About” in the product’s user interface for more information.

Legal Considerations
Camera surveillance can be prohibited by laws that vary from country to country. Check the laws in your local region before using this product for surveillance purposes.

Electromagnetic Compatibility (EMC)
This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures: Re-orient or relocate the receiving antenna. Increase the separation between the equipment and receiver. Connect the equipment to an outlet on a different circuit to the receiver. Consult your dealer or an experienced radio/TV technician for help. Shielded (STP) network cables must be used with this unit to ensure compliance with EMC standards.

USA - This device complies with RSS-210 of Industry Canada. Operation is subject to the following conditions: (1) This device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

Canada - This digital equipment fulfills the requirements for radiation emission according to limit B of EN55022/1998, and the requirements for immunity according to EN55024/1998 residential, commercial, and light industry.

Liability
Every care has been taken in the preparation of this manual; please inform your local Axis office of any inaccuracies or omissions. Axis Communications AB cannot be held responsible for any technical or typographical errors and reserves the right to make changes to the product and manuals without prior notice. Axis Communications AB makes no warranty of any kind with regard to the material contained within this document, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. Axis Communications AB shall not be liable nor responsible for incidental or consequential damages in connection with the furnishing, performance or use of this material.

Trademark Acknowledgments
Acrobat, Adobe, Boa, Ethernet, IBM, Internet Explorer, LAN Manager, Linux, Macintosh, Microsoft, Mozilla, Netscape Navigator, OS/2, UNIX, Windows, WWW are registered trademarks of the respective holders. Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and other countries. Axis Communications AB is independent of Sun Microsystems Inc. UPnP™ is a certification mark of the UPnP™ Implementers Corporation.

Support Services
Should you require any technical assistance, please contact your Axis reseller. If your questions cannot be answered immediately, your reseller will forward your queries through the appropriate channels to ensure a rapid response. If you are connected to the Internet, you can:
• download user documentation and firmware updates
• find answers to resolved problems in the FAQ database. Search by product, category, or phrases
• report problems to Axis support staff by logging in to your private support area
• visit the Axis Support Web at www.axis.com/techsup/

Safety Notice - Battery Replacement
The AXIS 240Q uses a 3.0V CR2032 Lithium battery as the power supply for its internal real-time clock (RTC). This battery will, under normal conditions, last for a minimum of 5 years. Low battery power affects the operation of the RTC, causing it to reset at every power-up. A log message will appear when battery replacement is required. The battery should not be replaced unless required!

If the battery does need replacing, observe the following points:
• Caution! Danger of Explosion if battery is incorrectly replaced
• Replace only with the same or equivalent battery, as recommended by the manufacturer.
• Dispose of used batteries according to the manufacturer’s instructions.

AXIS 240Q User’s Manual
Revision 1.3, January 2009
Part No: 28039
Copyright© Axis Communications AB, 2006-2009
# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Description</td>
<td>5</td>
</tr>
<tr>
<td>AXIS 240Q Front Panel</td>
<td>6</td>
</tr>
<tr>
<td>AXIS 240Q Rear Panel</td>
<td>7</td>
</tr>
<tr>
<td>Using the video server</td>
<td>8</td>
</tr>
<tr>
<td>Accessing the video server</td>
<td>8</td>
</tr>
<tr>
<td>The Live View page</td>
<td>9</td>
</tr>
<tr>
<td>Video Streams</td>
<td>10</td>
</tr>
<tr>
<td>Motion JPEG</td>
<td>10</td>
</tr>
<tr>
<td>The AXIS Media Control (AMC)</td>
<td>10</td>
</tr>
<tr>
<td>Other methods of accessing the video stream</td>
<td>11</td>
</tr>
<tr>
<td>Configuring the video server</td>
<td>12</td>
</tr>
<tr>
<td>Accessing the Setup tools</td>
<td>12</td>
</tr>
<tr>
<td>Video &amp; Image Settings</td>
<td>13</td>
</tr>
<tr>
<td>Image Settings</td>
<td>13</td>
</tr>
<tr>
<td>Video Source Settings</td>
<td>14</td>
</tr>
<tr>
<td>Overlay/ Mask settings</td>
<td>15</td>
</tr>
<tr>
<td>Live View Config</td>
<td>18</td>
</tr>
<tr>
<td>Layout</td>
<td>18</td>
</tr>
<tr>
<td>HTML Examples</td>
<td>21</td>
</tr>
<tr>
<td>External Video</td>
<td>21</td>
</tr>
<tr>
<td>Sequence Mode</td>
<td>21</td>
</tr>
<tr>
<td>Event Configuration</td>
<td>22</td>
</tr>
<tr>
<td>Event Servers</td>
<td>22</td>
</tr>
<tr>
<td>Event Types</td>
<td>23</td>
</tr>
<tr>
<td>Motion Detection</td>
<td>25</td>
</tr>
<tr>
<td>Port Status</td>
<td>26</td>
</tr>
<tr>
<td>Pan Tilt Zoom</td>
<td>27</td>
</tr>
<tr>
<td>Installing PTZ Devices</td>
<td>27</td>
</tr>
<tr>
<td>PTZ Configuration</td>
<td>28</td>
</tr>
<tr>
<td>PTZ Controls</td>
<td>29</td>
</tr>
<tr>
<td>System Options</td>
<td>34</td>
</tr>
<tr>
<td>Security - Users</td>
<td>34</td>
</tr>
<tr>
<td>802.1x - Network Admission Control</td>
<td>35</td>
</tr>
<tr>
<td>Date &amp; Time</td>
<td>37</td>
</tr>
<tr>
<td>Network - Basic TCP/IP Settings</td>
<td>37</td>
</tr>
</tbody>
</table>
The AXIS 240Q is a fully featured video server for security surveillance and remote monitoring needs. Based on the AXIS ARTPEC-2 compression chip, it can digitize up to 4 analog video sources and make these available on the network as real-time Motion JPEG video streams, at a maximum frame rate of 5 (PAL) or 6 (NTSC) frames per second.

Video can be viewed in 5 resolutions (up to 4CIF), and image compression is configurable. Up to 20 viewers can access the video server simultaneously.

The AXIS 240Q is equipped with RS-232 and RS-485 ports for the connection of third party PTZ devices. It also has 4 alarm inputs and 4 alarm outputs, which can be used to connect various third party devices, e.g. door sensors, alarm bells, etc.

The AXIS 240Q also contains support for video motion detection, which allows the unit to trigger on activity in the video image, and advanced scheduling tools that can also be used to trigger an event. As the video server is designed for use in security systems, it is equipped with several security features, such as HTTPS, IP address filtering and multiple user levels with passwords.

The AXIS 240Q has a built-in web server, providing full access to all features through the use of a standard browser. The built-in scripting tool allows the creation of basic applications, providing basic surveillance solutions.

For advanced functionality, the video server is easy to integrate through the use of the AXIS HTTP API (see www.axis.com/developer).
AXIS 240Q Front Panel

Indicators - After completion of the startup and self-test routines, the multi-colored Network, Status, Power Indicators flash as follows:

<table>
<thead>
<tr>
<th>Network</th>
<th>Unlit</th>
<th>No connection.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Green</td>
<td>Steady for connection to a 100 Mbit/s network. Flashes for network activity.</td>
</tr>
<tr>
<td></td>
<td>Amber</td>
<td>Steady for connection to a 10 Mbit/s network. Flashes for network activity.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status</th>
<th>Unlit</th>
<th>When configured for &quot;no flash&quot; on camera access.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Green</td>
<td>Steady for normal operation. Can be configured to flash green at intervals whenever the camera is accessed. See the online help for more information.</td>
</tr>
<tr>
<td></td>
<td>Amber</td>
<td>Steady during startup, reset to factory default or when restoring settings.</td>
</tr>
<tr>
<td></td>
<td>Red</td>
<td>Slow flash for failed upgrade.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Power</th>
<th>Green</th>
<th>Normal operation.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Amber</td>
<td>Flashes green/amber during firmware upgrade.</td>
</tr>
</tbody>
</table>

Note: If the AXIS 240Q is to be connected in parallel with other equipment, disable the input termination by turning the corresponding DIP switch to the up position (OFF). Failure to do so may impair the image quality.

Control Button - Press this button to restore the factory default settings, as described in Resetting to the Factory Default Settings, on page 44, or to install using AXIS Internet Dynamic DNS Service (page 15).

Video Inputs - Accommodates up to 4 separate video sources (VIDEO 1 - VIDEO 4) simultaneously. Each supported video input is connected using a coax/BNC connector. Physical connections made using e.g. 75 Ohm coax video cable have a recommended maximum length of 800 feet (250 meters).
AXIS 240Q Rear Panel

The Serial Number is located on the label on the underside of the unit.

**Power adapter connector** - A single socket for connection of the PS-K power adapter.

**I/O Terminal connector** - The I/O Terminal connector provides the physical interface to 4 digital transistor outputs, 4 digital inputs and an RS-485 interface. See *Unit Connectors*, on page 45 for more information.

*Note:* The I/O Terminal connector also provides an auxiliary connection point for DC power.

**Network Connector** - The AXIS 240Q connects to the network via a standard network cable. The AXIS 240Q detects the speed of the local network segment (10BaseT/100BaseTX Ethernet).

**RS-232 Serial Connector** - A 9-pin D-sub connector providing an RS-232 serial connection. Typically used for connecting Pan/Tilt/Zoom devices. See *Unit Connectors*, on page 45 for more information.
AXIS 240Q - Using the video server

Using the video server

The AXIS 240Q can be used with most standard operating systems and web browsers. The recommended browser is Internet Explorer with Windows, and Mozilla with other operating systems. See also the Technical Specifications, on page 52.

Note: For information on installing the video server, please refer to the Installation Guide.

Accessing the video server

1. Start your browser.
2. Enter the IP address or host name of the AXIS 240Q in the Location/Address field of your browser.
3. Enter the user name and password set by the administrator.
4. The Live View page is displayed in your browser.
Notes:  
• To view streaming video in Microsoft Internet Explorer, you must set your web browser to allow the AXIS Media Control (AMC) to be installed on your computer.

• If your workstation restricts the use of additional software components, the AXIS 240Q can be configured to use a Java applet for updating JPEG images. Please see the online help for more information.

• When using a browser other than Microsoft Internet Explorer with AMC, instead of a stop, a snapshot and a full screen button, there is a stop and a play button in the bottom left corner of the live view page. For a description of these buttons see The Live View page, below.

The Live View page
If the AXIS 240Q has been customized, the buttons and other items described below will be displayed accordingly on the Live View page. The following provides an overview of each button:

The Video Format drop-down list allows the video format on the Live View page to be temporarily changed.

The Output buttons control an output directly from the Live View page. These buttons are configured under Setup > Live View Config > Layout.

These buttons start/stop the Sequence Mode. This mode is created in Setup > Live View Config > Sequence mode and automatically displays the view from 2 or more video sources at set intervals.

From the Source list, select the desired video image(s). The list can contain internal video sources, external video sources, or the Quad Stream view. The Quad Stream option displays all four video images in one stream.

The Action buttons trigger an event directly from the Live View page. These buttons are configured under Setup > Live View Config > Layout. Click these buttons to manually start and stop events.

Use the Snapshot button to capture a snapshot of the image currently being displayed in the window. Right-click on the image to save it in on your computer.

Pulse - click this button to activate the port for a defined period of time, e.g. to switch on a light for 20 seconds.

Active/Inactive - click these buttons to manually start and stop a connected device, e.g. switch a light on/off.
The AMC viewer toolbar (AXIS Media Control) is available in Microsoft Internet Explorer only and displays the following buttons:

- The **Play/Stop** buttons start and stop the live video stream.
- The **Snapshot** button takes a snapshot of the currently displayed image. The Snapshot function and the target directory for saving snapshots can be configured from AMC (AXIS Media Control), which is available from the Windows Control Panel (Internet Explorer only).
- Click the **View Full Screen** button and the video image will fill the entire screen area. No other windows will be visible. Press Esc (Escape) on your keyboard to cancel full screen view.

Note that these AMC toolbar functions can also be accessed by right-clicking in the image.

For information on using Pan/Tilt/Zoom controls, please see page 27.

---

**Video Streams**

The Live View page in the AXIS 240Q provides access to Motion JPEG video streams, as well as to single JPEG images. Other applications and clients can also access these video streams/images directly, without going via the Live View page.

**Motion JPEG**

This format uses standard JPEG still images in the video stream. These images are then displayed and updated at a rate sufficient to create a stream that shows constantly updated motion.

The Motion JPEG stream provides excellent image quality and access to each and every individual image contained in the stream. The level of image compression may need to be increased if bandwidth consumption is a problem.

Note also that multiple clients accessing Motion JPEG streams can use different image settings.

**The AXIS Media Control (AMC)**

The recommended method of accessing live video (Motion JPEG) from the AXIS 240Q is to use the AXIS Media Control (AMC) in Microsoft Internet Explorer in Windows. This ActiveX component is automatically installed on first use, after which it can be configured by opening the AMC Control Panel applet from the Windows Control Panel. Alternatively, right-click the video image in Internet Explorer.
Other methods of accessing the video stream

Video and images from the AXIS 240Q can also be accessed in the following ways:

- If supported by the client, the AXIS 240Q can use Motion JPEG server push to display video. This option maintains an open HTTP connection to the browser and sends data as and when required, for as long as required.

- As single JPEG images in a browser. Enter e.g. the path: http://<ip>/axis-cgi/jpg/image.cgi?resolution=CIF
Configuring the video server

This section describes how to configure the AXIS 240Q and is intended for administrators, who have unrestricted access to all the Setup tools.

The AXIS 240Q is configured from the Setup link, in a standard browser. For more information on supported browsers, see the Technical Specifications, on page 52.

Accessing the Setup tools

Follow the instructions below to access the Setup Tools from a browser.

1. Start the browser and enter the IP address or host name of the AXIS 240Q in the location/address field.

2. The Live View page is now displayed. Click Setup to display the Setup tools.
Video & Image Settings

The following descriptions show examples of the available features in the AXIS 240Q. For details about each setting, please refer to the online help available from each page. Click 🛠 to access the online help.

Image Settings

Modify the Image Appearance to optimize the video images according to your requirements.

All configuration of images and overlays will affect the performance of the video server, depending on the usage and the available bandwidth.

- High resolution generates larger files
- Lower compression improves image quality, but generates larger files
- Black & White uses less bandwidth than Color
- Rotating the image 90 or 270 degrees will lower the maximum frame rate

See also the specifications for frame rates and bandwidth on page 52.
Text Overlay Settings
Include date, time and/or text of your choice to be viewed on the image. The color of the text may be set to white or black, while background color may be set to white, black, transparent or semitransparent. The position of the text is set either to the top or the bottom of the image.

Video stream
The Maximum video stream time can be set as Unlimited, or set a maximum stream time per session in seconds, minutes or hours. When the set time has expired, a new stream on the Live View page can be started by refreshing the page in the web browser. Note that the maximum video stream time does not apply to clients connecting via multicast.

To avoid bandwidth problems on the network, the frame rate allowed to each viewer can also be limited. Select either Unlimited or define a maximum frame rate per viewer.

Test
For a preview of the image and overlay settings before saving, click Test. When you are satisfied with the settings, click Save.

Video Source Settings
Enter a descriptive name for the Video source.
Black borders surrounding the image can be eliminated by adjusting the offset position. See the online help for more information.
Overlay/Mask settings

Overlay/Mask type

Overlay/Mask type allows you to place an overlay, or up to three privacy masks over the video image:

- Upload and place an image as an overlay - usually used to provide extra information in the video image.
- Place up to 3 configurable privacy masks to conceal different areas of the video image.

Selecting the overlay/mask type from the menu will display further settings available for the selected type. See the online help for further information.

Note: A privacy mask cannot be bypassed, but an overlay image can be bypassed with the help of the AXIS VAPIX API.

Upload and use an overlay image

1. Select **Uploaded image as overlay** in the drop-down list for **Overlay/Mask Type**. New options appear.

2. In the field **Upload own image**, click the **Browse** button and locate the image file on your computer or server.

3. Click the **Upload** button and follow the on-screen instructions.

To use an already uploaded image:

1. Select an uploaded image from the **Use image** drop-down list.
2. Place the image at the required location by entering the x and y coordinates.
3. Click **Save**.
Overlay image requirements:

- The maximum overlay image size supported by the AXIS 240Q is the same as the maximum image resolution. See Technical Specifications, on page 52.
- When a text overlay is also used, this reduces the amount of space available to the overlay image. To keep the text readable at lower resolutions, the text overlay occupies proportionally more of the image at lower resolutions.
- If the overlay is initially positioned so that part of it is outside the video image, it will be relocated so that it appears over the video image, i.e. it is always the entire image that is displayed.

Please see the online help for more information.

Overlay image limitations:

<table>
<thead>
<tr>
<th>Image Formats</th>
<th>Image Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 24-bit BMP (full color)</td>
<td>The height and width of the overlay image in pixels must be exactly divisible by 4.</td>
</tr>
<tr>
<td>Windows 4-bit BMP (16 colors)</td>
<td></td>
</tr>
</tbody>
</table>
Use a Privacy Mask
To use privacy masks to hide different areas of the video image:

1. Select **Configurable areas as privacy mask** in the drop-down list for Overlay/Mask Type. New options appear.

2. Enter the (x,y) coordinates of the top left hand corner of the mask, and the height and width to define the masks’ placement and size.

3. Select the privacy masks’ color: black, grey, white, or red.

4. Click in the box beside **Enable** to enable one or more of the masks you have defined and click on **Save**.

Please see the online help for more information.
Live View Config

Layout

These are the tools for deciding the layout of the Live View page.

The layout can be set in 3 ways:

- Use Axis look - the layout is unchanged.
- Use custom settings - modify the default page with your own colors, images etc. Click the Configure button and see the following page.
- Own Home Page - Upload and use your own custom made page as the default web page. Click the Configure button and see the following page.

The other settings on this page concern which other features to include, e.g. buttons and links. See page 20 for more information.
Customizing the default page

The appearance of the default AXIS 240Q Live View page can be customized to suit your own requirements, or you can upload and use your own home page.

To upload your own files, click the **Upload/Remove** button and see the description below.

**Upload Own Web Files**

Your own web files, background pictures, etc. must first be uploaded to the AXIS 240Q in order to be available for selection in the **Custom Settings setup** dialog. Once uploaded, the files are shown in the drop-down list.

1. Enter the path to the file, e.g. a file located on your workstation or click the **Browse** button.
2. Select the user level for the uploaded file. Setting the user access level means that you have complete control over which pages can be viewed by which users.
3. When the path is shown correctly in the text field, click the **Upload** button. Uploaded files are now shown in the list in the lower section of the page.
4. To use your uploaded file, click the radio button and select the file from the drop-down list by **Own**.

To remove a file, check the box provided next to it and then click the **Remove** button.

To use an external file located somewhere other than in the AXIS 240Q, select this radio button and enter the URL in the field marked **External**.

**Own Home Page**

To use a previously uploaded web page as the default page, check this box, select the page from the drop-down list and click OK.

Note that the setup address is http://<ip address>/operator/basic.shtml
User Defined Links

Enter a descriptive name and enter the URL in the provided field. The link will appear on the Live View page.

User defined CGI links can be used to issue HTTP API requests, e.g. PTZ commands.

Example:

1. Check Show Custom Link 1
2. Enter a descriptive name, e.g. CAM1 Start PTZ.
3. Enter the cgi link:
   http://192.168.0.125/axis-cgi/com/ptz.cgi?camera=1&continuouspantiltmove=30,-30
4. Check Show Custom Link 2.
5. Enter a descriptive name, e.g. CAM1 Stop PTZ.
6. Enter the cgi link:
   http://192.168.0.125/axis-cgi/com/ptz.cgi?camera=1&continuouspantiltmove=0,0
7. These links will appear in the web interface and can be used to control the PTZ camera

For more information on the Axis HTTP API, see the Support / Developer pages on the Axis Web site at http://www.axis.com. See also the section on PTZ, on page 27.

Action Buttons

These buttons can be used to manually trigger and stop an event from the Live View page. See Event Servers, on page 22. The snapshot button allows you to take a snapshot of the video stream and save it to a computer.

Output Buttons

These buttons are used to control the outputs on the AXIS 240Q and thus the equipment connected to them, e.g. to switch a light on or off:

- The Pulse button activates the port for a defined period
- Active/Inactive displays 2 buttons, one for each action (on/off)

Default Viewer for Motion JPEG

Select the appropriate radio button to define the method for viewing moving video images, depending on your browser and settings.

Please see the online help 🟢 for more information.
Default Viewer
Select from the drop-down list the viewer you wish to use for your web browser. Please see the online help for more information.

Viewer Settings
Show crosshair in PTZ joystick mode - This will enable the display of a crosshair in the video image when the PTZ mode is set to joystick.

Use PTZ joystick mode as default - Enabling this sets the PTZ mode to joystick. The mode can be changed temporarily on the PTZ Control Panel, but will default to joystick if this is selected.

HTML Examples
You can add live video from your AXIS 240Q to your own web site. The video server can send Motion-JPEG images to up to 20 simultaneous connections, although an administrator can restrict this to fewer.

Enter the Image Type, Image size and other settings to suit your web page and click Update.

External Video
You can add links to other Axis network devices available over the network. These sources can be displayed on the Live View page, just as if they were video sources connected directly to the AXIS 240Q.

Click the Add button to open the External Video Source Setup dialog, which is used to make all the necessary settings.

Example of a path to an external video source:

```
http://192.168.0.125/axis-cgi/mjpeg/video.cgi
```

Sequence Mode
The Live View page can be configured to rotate through selected internal and/or external video sources, in order or randomly. PTZ preset positions can also be included.

Select the desired video sources and enter the time in seconds to display each source (up to 59 minutes). Click Save.

The Sequence buttons will appear on the Live View page to allow the viewer to start and stop the sequence mode.

To show the selected video sources in random order, check the box provided.
Event Configuration

This section describes how to configure the AXIS 240Q for alarm handling. Various actions can be configured to run when certain types of events occur.

<table>
<thead>
<tr>
<th>Event type</th>
<th>A set of parameters describing how and when the video server is to perform certain actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triggered Event</td>
<td>- the circumstances that start an event</td>
</tr>
<tr>
<td>Scheduled Event</td>
<td>- the circumstances that start an event</td>
</tr>
<tr>
<td>Action</td>
<td>- what occurs when the event runs</td>
</tr>
</tbody>
</table>

**Event Servers**

Event Servers are used for e.g. receiving uploaded image files and/or notification messages. To set up Event server for your AXIS 240Q, go to Setup > Event Configuration > Event Servers and enter the required information according to the selected server type.

<table>
<thead>
<tr>
<th>Server type</th>
<th>Purpose</th>
<th>Information required</th>
</tr>
</thead>
</table>
| FTP Server   | • receives uploaded images       | • Descriptive name of your choice  
|              |                                  | • User Name and Password (to FTP server)   
|              |                                  | • Upload path, e.g. images/             
|              |                                  | • Port number                          
|              |                                  | • Use passive mode if there is a firewall between the video server and FTP server   |
| HTTP Server  | • receives notification messages | • Descriptive name of your choice  
|              | • receives uploaded images       | • URL (address)                        
|              |                                  | • User Name and Password (to HTTP server)  
|              |                                  | • Proxy address/Proxy port (if required) 
|              |                                  | • Proxy User Name and Password (if required)  
| TCP Server   | • receives notification messages | • Descriptive name of your choice  
|              |                                  | • User Name and Password (for TCP server) 
|              |                                  | • Port number                          |

For details on each setting, please refer to the online help available from each web page.

**Note:** Pre-trigger and Post-trigger buffers will be lost if the connection to the event server fails.

When the setup is complete, the connection can be tested by clicking the Test button (the connection test takes approximately 10 seconds).
Event Types
An Event Type is a set of parameters describing how and when the video server is to perform certain actions.

Example: If somebody walks past the connected camera, and an event has been configured to act on this, the video server can e.g. record and send video images to an FTP server, or send a notification email to a pre-configured email address with a pre-configured message. Video images can be sent as an attachment with the email.

Triggered Event
A triggered event is activated by e.g:

- a push button connected to an input port on the video server
- detected movement in a configured motion detection window
- a lost signal from a video source
- a manually activated action e.g. from an action button in the web interface
- on restart (reboot) after e.g. power loss

How to set up a triggered event
This example describes how to set the video server to upload images when the main door is opened:

1. Click Add triggered on the Event types page.
2. Enter a descriptive name for the event, e.g. Main door.
3. Set the priority - High, Normal or Low (see online help files).
4. Select which Video Source the event is to act on, e.g. Video 1 on Main door.
5. Set the Respond to Trigger... parameters when the event is to be active, e.g. only after office hours
6. Select the trigger alternative from the Triggered by... drop-down list, e.g. an Input port with a connected sensor if the door is opened.
7. Set the When Triggered... parameters, i.e. set what the video server should do if the main door is opened, e.g. upload images to an FTP server.
8. Click OK to save the event in the Event Types list.

Please see the online help for descriptions of each available option.
Pre-trigger and Post-trigger buffers

This function is very useful when checking to see what happened immediately before and after a trigger, e.g. 2 minutes before and after a door was opened. Check the Upload images checkbox under Event Types > Add Triggered... > Triggered by... to expand the web page with the available options.

Up to 3 MB of memory (per video source) is available for the pre-/post-trigger buffer. The maximum length of the video actually saved in the buffer depends on the selected image size and frame rate.

Include pre-trigger buffer - images stored internally in the server from the time immediately preceding the trigger. Check the box to enable the pre-trigger buffer, enter the desired length of time and specify the required image frequency.

Include post-trigger buffer - contains images from the time immediately after the trigger. Configure as for pre-trigger.

Note: If the pre- or post-buffer is too large for the internal memory in the AXIS 240Q, the frame rate will be reduced and individual images may be missing. If this occurs, an entry will be created in the unit’s log file.

Continue image upload (unbuffered) - enable the upload of images for a fixed length of time. Specify the length of time for the uploaded recording, in seconds, minutes or hours, or for as long as the trigger is active. Finally, set the desired image frequency to the maximum (the maximum available) or to a specified frame rate. The frame rate will be the best possible, but might not be as high as specified, especially if uploading via a slow connection.

Scheduled Event

A Scheduled event can be activated at pre-set times, in a repeating pattern on selected weekdays.

How to set up a scheduled event

This example describes how to set the video server to send an email notification with saved images from a set time:

1. Click Add scheduled on the Event types page.
2. Enter a descriptive name for the event, e.g. Scheduled email.
3. Set the priority (High, Normal or Low).
4. Select the video source i.e. the source the event should act on, e.g. Video 2 in Storage room.
5. Set the Activation Time parameters (24h clock) when the event should be active, e.g. start on Sundays at 13.00 with a duration of 12 hours.
6. Set the When Activated... parameters, i.e. specify what the video server should do at the specified time, e.g. send uploaded images to an email address.
7. Click **OK** to save the Event in the Event Types list.

Please see the online help 🛠 for descriptions of each available option.

### Motion Detection

In the Motion Detection menu, you can configure the video source(s) for motion detection. The motion detection feature is used to generate an alarm whenever movement occurs (or stops) in the image. Motion detection is configured in Include/Exclude windows, of which up to 40 (10 per video source) can be configured.

- **Include** windows target specific areas within the whole image
- **Exclude** windows are areas to be ignored within the Include window

Once configured, the motion detection windows will appear in a list when motion detection is selected to trigger an event. See *How to set up a triggered event* above.

**Note:** Using the motion detection feature may decrease overall performance in the video server.

---

**How to configure Motion Detection**

This example describes how to configure Video 1 for motion detection:

1. Click **Motion Detection** in the **Event Configuration** menu.
2. Select video source 1 from the menu.
3. Click the **Configure Included Windows** radio button.
4. Click **New**.
5. Enter a descriptive name of your choice under **Windows name**.
6. Adjust the size (drag the bottom right-hand corner) and position (click on the text at the top and drag to the desired position).

7. Adjust the Object size, History and Sensitivity profile sliders (see table below for details). Any detected motion within an active window is then indicated by red peaks in the Activity window (the active window has a red frame).

8. Click Save.

If there are parts of the Include window that you wish to exclude, click the Configure Excluded Windows radio button and repeat steps 1-8 above.

Please use the online help for descriptions of each available option.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Size</th>
<th>History</th>
<th>Sensitivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Only very large objects trigger motion detection</td>
<td>An object that appears in the region will trigger the motion detection for a long period</td>
<td>Ordinary colored objects against ordinary backgrounds will trigger the motion detection</td>
</tr>
<tr>
<td>Low</td>
<td>Even very small objects trigger motion detection</td>
<td>An object that appears in the region will trigger motion detection for only a very short period</td>
<td>Only very bright objects against a dark background will trigger motion detection</td>
</tr>
<tr>
<td>Default values</td>
<td>Low</td>
<td>Medium to High</td>
<td>Medium to High</td>
</tr>
</tbody>
</table>

Examples:
- Avoid triggering on small objects in the image by selecting a high size level.
- To trigger motion detection as long as there is activity in the area, select a high history level.
- To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is recommended.

Port Status

Under Event Configuration > Port Status, there is a list that shows the status for the connected inputs and outputs of the AXIS 240Q. This is for the benefit of an operator, who cannot access the System Options section.

Example: If the Normal state for a push button connected to an input is set to Open circuit, as long as the button is not pushed, the state is inactive. If the button is pushed, the state of the input changes to active.
Installing PTZ Devices

The AXIS 240Q supports several PTZ devices. Please see www.axis.com for a complete list of supported devices, and to obtain the correct driver. Follow the instructions below to install a PTZ device:

1. Using an appropriate cable, connect the device to your selected port (RS-232 or RS-485). These ports are available via the D-Sub connector and the I/O terminal connector, respectively. See page 47 for more information.

2. In the setup tools, go to Setup > System Options > Ports & Devices and then select either port RS-232 or RS-485 to configure. See the figure below.

3. Select Pan Tilt Zoom from the Usage drop-down list.

4. Click Upload to install a PTZ driver. (PTZ drivers are available from the Axis Web site at www.axis.com)

5. Click Port Options... to modify the port settings. The default values correspond to the values specified by the PTZ driver.

6. From System Options > Ports & Devices, select the port configured for PTZ and then select the video source to use with the device.

7. If required, click the Advanced Options button to make further settings and see the online help.
Note: Advanced users and application developers can also use the Axis Application Programming Interface and HTTP specification for generic control of PTZ devices using CGI commands or a TCP/IP client. Please refer to the Axis Website at www.axis.com for further information.

PTZ Configuration

Once PTZ has been installed for the AXIS 240Q, PTZ Configuration now appears in the menu to the left along with the following submenus.

Preset Positions

A preset position is a pre-defined camera view than can be used to quickly move the camera to a specific location.

From Preset Position Setup, use the Pan, Tilt and Zoom (PTZ) controls to steer the camera to the required position. When satisfied with the camera’s position, enter a descriptive name. The camera position, iris and focus settings are then saved as a preset position.

The position can be assumed at any time, by selecting the preset’s name from the Preset positions drop-down list. Preset positions can be selected in Live View, from events and in Sequence mode.

One position can be set as the Home position, which is readily accessible by clicking in the box beside Use current position as Home. The position’s name will then have (H) added, e.g. Office Entrance (H).
PTZ Controls

If the AXIS 240Q has been appropriately configured, the Live View page will display the controls available for the installed Pan Tilt Zoom (PTZ) device. The administrator can enable/disable the controls for specified users.

The exact controls shown depends on the make and model of PTZ device. There may be e.g. Focus and Iris bars available as well, but the most common controls are:

- the Pan bar - moves the camera to the right and left
- the Tilt bar - tips the camera up and down
- the Zoom bar - zooms the view in and out. Note that this is only available if the camera is fitted with a zoom lens.
- the Iris bar - adjusts the brightness of the image

Clicking on the bars themselves or on the arrows at the end of the bars will move the camera to a new position. The type of movement and the location of this new position depends on the type of PTZ driver.

When controlling the camera using a relative PTZ driver (see the bars in the illustration above) the new position will be relative to the previous position, e.g. left of, below, above, etc. Clicking the bar further from the center results in a larger movement.
In contrast, when using an **absolute** driver, each position on the bar (see right) represents a defined position in the device’s range of movement, with the center of the bar representing the point midway between the two extremes of movement.

Clicking a position directly on the bar moves the camera directly to the new position in one smooth movement. Clicking on the arrows at the ends of a bar causes a stepped, incremental change.

**Using CGI links to control PTZ devices**

User-defined CGI links on the Live View page can be used to issue HTTP API requests, e.g. PTZ commands. These links are configured in the Live View Layout settings, see page 8.

**PTZ Control Modes**

The PTZ device can also be controlled using **click-in-image** movement, which has two different types of navigation; **Center** and **Joystick**.

**Center** mode means that when clicking in the image, the camera view will center on the absolute position that was clicked.

Joystick mode moves the camera in the direction of the mouse pointer. By clicking and holding the mouse button down in the image, the PTZ device moves the camera in that direction, relative to the center of the image. The further from the center the image is clicked, the greater the movement. The camera stops moving when the button is released.

**Note:** There is also joystick support in AXIS Media Control (AMC).

**Control Panel**

The focus and iris (image brightness) can be adjusted manually by using the control bars, or they can be set for automatic adjustment, by clicking the **Auto iris** and **Auto focus** buttons.

To access the **Auto iris** and **Auto focus** buttons, click on the **Control panel** button. The menu to the right will then appear in the upper left hand corner of the screen.

There are also driver specific shortcuts that can appear in the Control Panel. In the screen to the right, a driver has been installed that brings up the **Wiper** shortcut button, which allows the user to configure and use a windshield wiping action with the AXIS 240Q.
Preset Positions

Also available with many PTZ devices are **Preset positions**. These presets are selected from the drop-down **Source** list on the Live View page and will move and/or zoom the camera to a pre-defined position, i.e. to cover an area of particular interest. Events can also be configured to go to preset positions when triggered. For information on setting up preset positions, please see *Preset Positions*, on page 28 and the online help.

Guard Tour

A guard tour moves between chosen **Preset Positions**, one-by-one, in a pre-determined order or randomly, and for configurable time periods. Unlike the **Sequence Mode**, which is a viewing application under **Live View Config** (see *Live View Config*, on page 18), the guard tour sequence will keep running after the user has logged off or closed the Web browser.

Advanced

**Device Settings** - The device settings window is for driver specific settings, so the appearance of this window can vary depending on the driver installed. Options that can be configured include: **Driver Specific Settings for Video Source 1**, **Mechanical Limits for Moving Video Source 1**, **Light Control for Video Source 1**, and **Extended Driver Specific Settings for Video Source 1**.

**Ctrl Panel** - The **Panel View Settings** window contains tools for creating and saving short command buttons that are located under the **Control panel**. These buttons provide direct access to various built-in auxiliary commands provided by the PTZ driver and are displayed in the PTZ Panel.

**Limits** - Define the pan, tilt, zoom and focus limits for the AXIS 240Q. Movements to the left and right, up and down can be restricted to narrow the area under surveillance. The near focus limit can be set to avoid focusing on objects too close to the camera.
OSD Menu - If the PTZ unit supports an internal configuration menu, this can be accessed using the On-Screen Display (OSD). Configure the analog camera by opening and navigating through its internal menu in this display.

PTZ Control Queue
Use the PTZ Control Queue window to enable and disable PTZ queueing. This window allows you to set up a queue for viewers wanting to access the AXIS 240Q, and limits the number of viewers and the length of time each viewer can access and control PTZ. For more information on how to set up the control queue, please see the online help.

Note also that a viewer who belongs to a group (see Security - Users, on page 34) that has a higher PTZ priority can go in front of other users in the queue and take control of the AXIS 240Q.
The order of priority for taking control of the queue is listed below:

1. Administrators - An administrator may take the PTZ control regardless of who is currently first in queue. The administrator will be removed from queue 60 seconds after the their last PTZ control command.

2. Event - You can set up the AXIS 240Q to take control of the queue and move to a specific position for 20 seconds when triggered by an alarm. The event will immediately be place first in queue except when an administrator is in control. For more information see *Triggered Event*, on page 23.

3. Operator - Same as administrator with lower priority.

4. Guard Tour - Guard tour has control of PTZ for an indefinite period of time. It may be overridden by, Operator, Event or administrator. Guard Tour will resume when higher priority groups leaves the queue. For more information see *Guard Tour*, on page 31.

5. Viewer - Multiple viewers will need to wait for their turn. The viewer has 60 seconds to control PTZ until control is passed to the next viewer in queue.

**Note:** In order to be able to identify different users in the viewer group, cookies need to be enabled on the client.
System Options

Security - Users
User access control is enabled by default, when the administrator sets the root password on first access. New users are authorized with user names and passwords, or the administrator can choose to allow anonymous viewer login to the Live View page, as described below:

Users - the user list displays the authorized users and access levels:

<table>
<thead>
<tr>
<th>User</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewer</td>
<td>Provides the lowest level of access, which only allows the user access to the Live View page.</td>
</tr>
<tr>
<td>Operator</td>
<td>An Operator can view the Live View page, create and modify event types and adjust certain other settings. The Operator does not have access to the Systems Options configuration pages.</td>
</tr>
<tr>
<td>Administrator</td>
<td>An administrator has unrestricted access to the Setup Tools and can determine the registration of all other users.</td>
</tr>
</tbody>
</table>

User Settings - check the corresponding checkboxes to enable:

- **Anonymous viewer login** - allows any viewer direct access to the Live View page.
- **Anonymous PTZ control login** - allows any viewer access to the Pan Tilt Zoom controllers on the Live View page (if Pan/Tilt/Zoom is available).

IP address filtering
Checking the Enable IP address filtering box enables the IP address filtering function. Up to 256 IP address entries may be specified (a single entry can contain multiple IP addresses). Click the Add button to add new filtered addresses.

When the IP address filter is enabled, addresses added to the list are set as allowed or denied addresses. All other IP addresses not in this list will then be allowed or denied access accordingly, i.e. if the addresses in the list are allowed, then all others are denied access, and vice versa. See also the online help for more information.

Note that users from IP addresses that will be allowed must also be registered with the appropriate access rights (User, Operator or Administrator). This is done from Setup > System Options > Security > Users.

Referrals - to prevent unauthorized sources from including the video stream from the AXIS 240Q into external Web pages, check the Referrals box and enter the IP address or Host name of the computer that hosts the Web pages with the included video stream. Multiple IP addresses/host names can be defined and are separated by semicolons (;

**Notes:**
- If the referrals feature is enabled and you wish to also allow normal access to the Live View page, the product's own IP address or host name must be added to the list of allowed referrers.
- Restricting referrers is of greatest value when not using IP address filtering. If IP address filtering is used, then the allowed referrers are automatically restricted to those allowed IP addresses.
HTTPS

For greater security, the AXIS 240Q can be configured to use HTTPS (Hypertext Transfer Protocol over SSL (Secure Socket Layer)). That is, all communication that would otherwise go via HTTP instead goes via an encrypted HTTPS connection.

Certificate - to use HTTPS for communication with the AXIS 240Q, a Certificate must be created using one of these methods:

- A self-signed certificate can be created in the video server, but this does not guarantee the same level of security as an official certificate.
- An official certificate issued by a CA (Certificate Authority). A CA issues and manages security credentials and public keys for message encryption.

1. Click either Create self-signed certificate or Create Certificate Request and enter the required information in the provided fields
2. Click OK.
3. Create self-signed certificate generates and installs a certificate which will be displayed under Installed Certificate.
   Create Certificate Request generates a PEM formatted request which you copy and send to a CA for signing. When the signed certificate is returned, click Install signed certificate... to install the certificate in the AXIS 240Q.
4. Set the HTTPS Connection Policy for the administrator, Operator and Viewer to enable HTTPS connection (set to HTTP by default)

Please refer to the home page of your preferred CA for information on where to send the request etc. For more information, please see the online help 🌐

802.1x - Network Admission Control

IEEE 802.1x is an IEEE standard for port-based Network Admission Control. It provides authentication to devices attached to a network port (wired or wireless), establishing a point-to-point connection, or, if authentication fails, preventing access on that port. 802.1x is based on EAP (Extensible Authentication Protocol).

In a 802.1x enabled network switch, clients equipped with the correct software can be authenticated and allowed or denied network access at the Ethernet level.

Clients and servers in an 802.1x network may need to authenticate each other by some means. In the Axis implementation this is done with the help of digital certificates provided by a Certification Authority. These are then validated by a third-party entity, such as a RADIUS server, examples of which are Free Radius and Microsoft Internet Authentication Service.
To perform the authentication, the RADIUS server uses various EAP methods/protocols, of which there are many. The one used in the Axis implementation is EAP-TLS (EAP-Transport Layer Security).

The AXIS network video device presents its certificate to the network switch, which in turn forwards this to the RADIUS server. The RADIUS server validates or rejects the certificate and responds to the switch, and sends its own certificate to the client for validation. The switch then allows or denies network access accordingly, on a preconfigured port.

The authentication process

1. A CA server provides the required signed certificates.
2. The Axis video device requests access to the protected network at the network switch. The switch forwards the video device’s CA certificate to the RADIUS server, which then replies to the switch.
3. The switch forwards the RADIUS server’s CA certificate to the video device, which also replies to the switch.
4. The switch keeps track of all responses to the validation requests. If all certificates are validated, the Axis video device is allowed access to the protected network via a preconfigured port.

RADIUS
RADIUS (Remote Authentication Dial In User Service) is an AAA (Authentication, Authorization and Accounting) protocol for applications such as network access or IP mobility. It is intended to work in both local and roaming situations.

CA servers

In cryptography, a Certification Authority (CA) is an entity that provides signed digital certificates for use by other parties, and thus acts a trusted third party.

There are many commercial CA’s that charge for their services. Institutions and governments may have their own CA, and there are free CA’s available.

Date & Time

Current Server Time - displays the current date and time (24h clock). The time can be displayed in 12h clock format in overlay images.

New Server Time - Select your time zone from the drop-down list and check the daylight saving time changes, if desired.

From the Time Mode section, select the preferred method to use for setting the time:

- Synchronize with computer time - sets the time from the clock on your computer.
- Synchronize with NTP Server - the video server will obtain the time from an NTP server every 60 minutes. Specify the NTP server’s IP address or host name.

Note: Note that if using a host name for the NTP server, a DNS server must be configured under TCP/IP settings. See Network > Advanced TCP/IP Settings below.

- Set manually - this option allows you to manually set the time and date.

Date & Time Format Used in Images - specify the formats for the date and time (12h or 24h) displayed in the Live View video streams.

Use the predefined formats or use your own custom date and time formats. See File Naming & Date/Time Formats in the online help for information on how to create your own file formats.

Network – Basic TCP/IP Settings

IP Address Configuration

Your Axis network camera supports both IP version 4 and IP version 6. Both versions may be enabled simultaneously, and at least one version must always be enabled.

When using IPv4, the IP address can be set automatically via DHCP, or a static IP address can be set manually.
If IPv6 is enabled, your camera will receive an IP address according to the configuration in the network router.

There are also options for setting up notification of changes in the IP address, and for using the AXIS Internet Dynamic DNS Service. For more information on setting the IP address, please see the online help.

**Notes:**

- DHCP is a protocol for automatic IP address assignment on a network. IP address assignment via DHCP may lead to the situation where the IP address changes and you lose contact. Configure the options for notification of IP address change (under Services) to receive notification from the video server when the IP address changes.
- Alternatively, if your DHCP server can update a DNS server, you can access the AXIS 240Q by host name which is always the same, regardless of the IP address.

**Services**

**Enable ARP/Ping setting of IP address** - The IP address can be set using the ARP/Ping method, which associates the unit’s MAC address with an IP address. Check this box to enable the service. Leave disabled to prevent unintentional resetting of the IP address.

**Notes:**

- The ARP/Ping service is automatically disabled 2 minutes after the unit is started, or as soon as an IP address is set.
- Pinging the unit will still be possible when this service is disabled.

**AXIS Internet Dynamic DNS Service** - If the AXIS 240Q has been registered with the Axis Internet Dynamic DNS service and the IP address for the product changes, the service is updated to reflect the change. Check the box to enable/disable automatic updates.

The domain name currently registered at the Axis Internet Dynamic DNS service for your product can at any time be removed. To do this click Settings... and follow the instructions. For more information, please refer to the online help 🤔
Network – Advanced TCP/IP Settings

DNS Configuration

DNS (Domain Name Service) provides the translation of host names to IP addresses on your network.

Obtain DNS server address via DHCP - automatically use the DNS server settings provided by the DHCP server. Click the View button to see the current settings.

Use the following DNS server address - enter the desired DNS server by specifying the following:

Domain name - enter the domain(s) to search for the host name used by the AXIS 240Q. Multiple domains can be separated by semicolons (;). The host name is always the first part of a Fully Qualified Domain Name, e.g. myserver is the host name in the Fully Qualified Domain Name myserver.mycompany.com where mycompany.com is the Domain name.

DNS servers - enter the IP addresses of the primary and secondary DNS servers.

NTP

Obtain NTP server address via DHCP - use a DHCP server to automatically find an NTP server to synchronize clock of the AXIS 240Q with the other devices on the network

Use the following NTP server address - use the host name or IP address of a specific NTP server for time synchronization.

Host Name Configuration

The AXIS 240Q can be accessed using a host name, instead of an IP address. The host name is usually the same as the assigned DNS Name.

For more information, please see the online help 📘

Link-Local Address

This is enabled by default and assigns the AXIS 240Q an additional IP address for use with UPnP™. The AXIS 240Q can have both a Link-Local IP and a static/DHCP-supplied IP address at the same time - these will not affect each other.

HTTP

The default HTTP port number (80) can be changed to any port within the range 1024-65535. This is useful for e.g. simple port mapping.

HTTPS

The default HTTP port number (443) can be changed to any port within the range 1024-65535. This is useful for e.g. simple port mapping.
NAT traversal

Use NAT traversal when your video server is located on an intranet and you want to make it available from the other side of a NAT router.

FTP

The FTP server running in the AXIS 240Q enables the upload of e.g. new firmware, user applications, etc. Check the box to enable the service.

Network Traffic

The default setting is Auto-negotiate which means that the correct speed is automatically selected. If necessary, you can set the connection speed by selecting it from the drop-down list.

Maximum bandwidth - Specify, in Mbit/s or kbit/s, the maximum bandwidth the AXIS 240Q is allowed to use on your network. This is a useful function when connecting the video server to busy or heavily loaded networks. The default setting is Unlimited.

For more information, please see the online help 🛠️

SOCKS

SOCKS is a networking proxy protocol. The AXIS 240Q can be configured to use a SOCKS server to reach networks on the other side of a firewall/proxy server. This functionality is useful if the video server is located on a local network behind a firewall, but notifications, uploads, alarms, etc., need to be sent to a destination outside the local network (e.g. to the Internet).

QoS (Quality of service)

Quality of Service (QoS) provides the means to guarantee a certain level of a specified resource to selected traffic on a network. Quality can be defined as e.g. a maintained level of bandwidth, low latency, no packet losses, etc. The main benefits of a QoS-aware network can be summarized as:

- The ability to prioritize traffic and thus allow critical flows to be served before flows with lesser priority.
- Greater reliability in the network, thanks to the control of the amount of bandwidth an application may use, and thus control over bandwidth races between applications.

The QoS in Axis network video products marks the data packets for various types of network traffic originating from the product. This makes it possible for network routers and switches to e.g. reserve a fixed amount of bandwidth for these types of traffic. The following types of traffic are marked:

- event/alarm traffic
- management network traffic.
QoS Settings
For each type of network traffic supported by your Axis network video product, enter a DSCP (Differentiated Services Codepoint) value. This value is used to mark the traffic’s IP header. When the marked traffic reaches a network router or switch, the DSCP value in the IP header tells the router or switch which type of treatment to apply to this type of traffic, for example, how much bandwidth to reserve for it.

Note that DSCP values can be entered in decimal or hex form, but saved values are always shown in decimal.

For more information on Quality of Service, please see the Axis support web at www.axis.com/techsup

SMTP (email)
Enter the host names or addresses for your primary and secondary mail servers in the fields provided, to enable event and error email messages from the video server to predefined addresses, via SMTP. If the mail server requires SMTP authentication, check the box for Use authentication to log in to this server and enter the user name and password used for logging in. Several different methods of authentication are available. See the online help for more information.

SNMP
The Simple Network Management Protocol (SNMP) allows the remote management of network devices. Select the version of SNMP to use, depending on the level of security required. Select the version of SNMP to use, by checking the appropriate box. The three levels of security are:

- SNMP V1 - includes no security
- SNMP V2c - uses very simple security, e.g. community name as password
- SNMP V3 - provides encryption and secure passwords. Use with HTTPS.

If using V1 and V2c, enter the community name for read-only access to all supported SNMP objects (except the root password and other objects that require write access). Default value = public. You can also specify the community name for read/write access to all supported SNMP objects (except read-only objects). Default value = pass.

If using HTTPS enter the password if it has not already been set. To set the password again, the AXIS 240Q must be reset to the factory default settings.

Network - UPnP™
The video server includes support for UPnP™ in Windows ME and Windows XP. UPnP™ is enabled by default.

Note: UPnP™ must be installed on your workstation. To do this, open the Control Panel from the Start Menu and select Add/Remove Programs. Select Add/Remove Windows Components and open the Networking Ser-
Bonjour
Your Axis network camera includes support for Bonjour. When enabled, the camera is automatically detected by operating systems and clients that support this protocol.

Ports & Devices
I/O Ports - the pinout, interface support and the control and monitoring functions provided by this connector are described in Unit Connectors, on page 45.

RS232 - The COM port RS-232 on the AXIS 240Q supports several operational modes listed on this page. For more information, please see COM Ports RS-232 and RS-485, on page 47.

RS485 - The COM ports on the AXIS 240Q supports several operational modes listed on this page. For more information, please see COM Ports RS-232 and RS-485, on page 47.

Maintenance
- **Restart** - The unit is restarted without changing any of the settings. Use this method if the unit is not behaving as expected.
- **Restore** - The unit is restarted and most current settings are reset to factory default values. The settings that will not be reset are:
  - the boot protocol (DHCP or static)
  - the static IP address
  - the default router
  - the subnet mask
  - the system time
- **Default** - The default button should be used with caution. Pressing this will return all of the video server’s settings (including the IP address) to the factory default values.

Upgrade Server - See Upgrading the Firmware, on page 48.

Backup - To take a backup of all of the parameters, and any user-defined scripts, click this button. If necessary, it is then possible to return to a previous configuration if settings are changed and there is unexpected behavior.

Restore - click the Browse button to locate the saved backup file (see above) and then click the Restore button. The settings will be restored to the previous configuration.

**Note**: Backup and Restore can only be used on the same unit running the same firmware. This feature is not intended for multi-configurations or for firmware upgrades.
Support
The support overview page provides valuable information on troubleshooting and contact information, should you require technical assistance.

The System Overview provides a summary of the status of the video server.

Logs & Reports - when contacting Axis support, please be sure to provide a valid Server Report with your query.

Information - The Log report and the Parameter List also provide valuable information for troubleshooting and when contacting Axis support service.

Configuration:
Log Level for Log Files - from the drop-down list, select the level of information to be added to the Log file.

Log Level for Email - from the drop-down list, select the level of information to send as email and enter the destination email address.

Advanced
Scripting is an advanced function that provides the possibility to customize and use scripts. This function is a very powerful tool.

Caution!
Improper use may cause unexpected behavior or even cause loss of contact with the unit. If a script does cause problems, reset the unit to its factory default settings. A backup file may be of use to return the unit to its latest configuration).

Axis strongly recommends that you do not use this function unless you fully understand the consequences. Note that Axis support does not provide assistance for problems with customized scripts.

For more information, please visit the Developer pages at www.axis.com/developer

Plain Config - this function is for the advanced user with experience of Axis video server configuration. All parameters can be set and modified from this page. Help is available from the standard help pages.
Resetting to the Factory Default Settings

To reset the AXIS 240Q to the original default settings, go to the System Options > Maintenance web page (as described in Maintenance, on page 42), or use the control button on the front panel, as described below:

Using the Control Button

1. Switch off the AXIS 240Q by disconnecting power.
2. Press and hold the Control button while you reconnect power.
3. Keep the Control button pressed until the Status Indicator displays yellow (this may take up to 15 seconds).
4. Release the Control button.
5. When the Status Indicator changes to Green (may take up to 1 minute), the process is complete and the AXIS 240Q has been reset.
6. Re-install the AXIS 240Q, as described in the Installation Guide.
Unit Connectors

The following connectors are described in this section:

- The D-Sub Connector, on page 45
- The I/O Terminal Connector, on page 46
- COM Ports RS-232 and RS-485, on page 47

The D-Sub Connector

The AXIS 240Q provides one 9-pin D-sub connector, providing the physical interface for an RS-232 port, used for connecting accessory equipment, such as PTZ devices for the remote control of connected video cameras.

Pin assignment table and pinout of the RS-232 connector:

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CD</td>
</tr>
<tr>
<td>2</td>
<td>- RXD</td>
</tr>
<tr>
<td>3</td>
<td>- TXD</td>
</tr>
<tr>
<td>4</td>
<td>DTR</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
</tr>
<tr>
<td>6</td>
<td>DSR</td>
</tr>
<tr>
<td>7</td>
<td>RTS</td>
</tr>
<tr>
<td>8</td>
<td>CTS</td>
</tr>
<tr>
<td>9</td>
<td>RI</td>
</tr>
</tbody>
</table>
The I/O Terminal Connector

This section describes the pinout and interface support provided by the 12-pin I/O terminal connector, which includes:

- 4 digital transistor outputs
- 4 digital inputs
- an RS-485 interface
- auxiliary power and GND

The terminal connector is used in applications for e.g. motion detection, event triggering, time lapse recording, alarm notification via email, image storage to FTP locations, etc.

- **Inputs** - e.g. a push button. If the button is pressed, the state changes, and the input will be active (shown under Event Configuration > Port Status).
- **Outputs** - e.g. an alarm device that can be activated from Output buttons on the Live View page or as an action to an Event Type. The output will show as active (in Event Configuration > Port Status), if the device is activated.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Auxiliary DC Power Input</td>
<td>7-20 VDC/min 7W. Electrically connected in parallel with PS-k power connector, provides an auxiliary connector for mains power to the unit. If the product is powered via this pin, use a fuse (Fuse rating: 1A Slow). This pin can also be used to power auxiliary equipment, max 100mA</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Digital Input 1</td>
<td>Connect to GND to activate or leave floating (or unconnected) to deactivate.</td>
</tr>
<tr>
<td>4</td>
<td>Digital Input 2</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Digital Input 3</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Digital Input 4</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Transistor Output</td>
<td>With a maximum load of 100mA and maximum voltage of 24V DC, this output has an open-collector NPN transistor with the emitter connected to pin 2 (GND). If it is to be used with an external relay, a diode must be connected in parallel with the load for protection against any voltage transients.</td>
</tr>
<tr>
<td>8</td>
<td>Transistor Output</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Transistor Output</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Transistor Output</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>RS-485 - A (non-inverting)</td>
<td>A half-duplex RS-485 interface for controlling auxiliary equipment, e.g. PTZ devices.</td>
</tr>
<tr>
<td>12</td>
<td>RS-485 - B (inverting)</td>
<td></td>
</tr>
</tbody>
</table>

The AXIS 240Q includes one (green) 12-pin terminal block. Connect input/output devices to this block:

1. Loosen the corresponding screw on top of the pin (see the table above to determine which pin to use).
2. Push the cable into the connector and secure it by fastening the screw.
3. Once all devices are connected, connect the terminal block to the video server’s terminal connector.
COM Ports RS-232 and RS-485

The COM Ports RS-232 and RS-485 support several operational modes:

- **Generic TCP/IP** - enables the video server to receive status/data and send commands via TCP/IP

- **Generic HTTP** - enables the video server to receive status/data and send commands via HTTP

- **Pan Tilt Zoom (PTZ)** - for controlling a PTZ device. A PTZ device requires a driver for its function. Please see page 27 for information on how to connect PTZ devices. Drivers can be obtained from www.axis.com
Troubleshooting

Checking the Firmware
Firmware is software that determines the functionality of the AXIS 240Q. One of your first actions when troubleshooting a problem should be to check the currently installed version. The latest version may contain a correction that fixes your particular problem. The current firmware version in your AXIS 240Q can be seen under Setup > Basic Configuration.

Upgrading the Firmware
When you download firmware from the Axis Web site, your Axis product will receive the latest available functionality. Always read the upgrade instructions and release notes available with each new release, before updating the firmware.

New firmware can be downloaded to the AXIS 240Q over the network.

Note: Pre-configured and customized settings will be retained for use when the new firmware is running (provided the features are available in the new firmware) although this is not guaranteed by Axis Communications.

1. Save the firmware file to your computer. The latest version of the AXIS 240Q firmware is available free of charge from the Axis Web site at www.axis.com/techsup or from your local distributor.
2. Go to Setup > System Options > Maintenance in the video server's Web pages.
3. In the Upgrade Server section and browse to the desired firmware file on your computer. Click Upgrade.

Notes: • Always read the upgrade instructions available with each new release, before updating the firmware.
• After starting the process, you should always wait at least 20 minutes before restarting the AXIS 240Q, even if you suspect the procedure has failed.
• Your dealer reserves the right to charge for any repair attributable to faulty updating by the user.
Emergency Recovery Procedure

If power or the network connection to the AXIS 240Q is lost during the upgrade, the process will fail and the unit will become unresponsive. A flashing red Status LED indicates a failed upgrade. To recover the unit, follow the steps below. The serial number is found on the underside label on the product casing.

1. **Unix/Linux** - From the command line, type the following:
   
   ```
   arp -s <IP address of AXIS 240Q> <Serial number> temp
   ping -s 408 <IP address of AXIS 240Q>
   ```

   **Windows** - From a command/DOS prompt, type the following:
   
   ```
   arp -s <IP address of AXIS 240Q> <Serial number>
   ping -l 408 -t <IP address of AXIS 240Q>
   ```

2. If the unit does not reply within a few seconds, restart it and wait for a reply. Press CTRL+C to stop Ping.

3. Open a browser and type in the AXIS 240Q’s IP address. In the page that appears, use the **Browse** button to select the upgrade file to use, e.g. axis240q.bin. Then click the **Load** button to restart the upgrade process.

4. After the upgrade has completed (1-10 minutes), the unit will automatically restart and show a steady green on the Power and Status LED’s and flashing green or amber on the Network LED.

5. Reinstall the AXIS 240Q. See the Installation Guide.

If the emergency recovery procedure does not get the AXIS 240Q up and running again, please contact Axis support at www.axis.com/techsup/

Support

If you contact Axis support, please help us help you resolve your problems expediently by providing a server report, log file and a brief description of the problem.

**Server Report** - go to **Setup > System Options > Support Overview**. The server report contains important information about the server and its software, as well as a list of the current parameters.

**Log file** - go to **Setup > System Options > Logs & Reports**. The Log file records events within the unit since the last restart of the system and can prove a useful diagnostic tool for troubleshooting.
Symptoms, Possible Causes and Remedial Actions

Problems setting the IP address

<table>
<thead>
<tr>
<th>Using ARP/Ping – the IP address must be set within two minutes after power has been applied to the video server</th>
<th>Restart the server and try again. Ensure also the ping length is set to 408. See or ARP and Ping in Windows on page 13, or ARP and Ping in UNIX/Linux on page 14.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The video server is located on a different subnet.</td>
<td>If the IP address intended for the AXIS 240Q and the IP address of your computer are located on different subnets, you will not be able to set the IP address. Contact your network administrator for an IP address on the same subnet as the computer you are performing the installation from.</td>
</tr>
<tr>
<td>The IP address is being used by another device</td>
<td>Disconnect power from the AXIS 240Q. Run the Ping command (in a Command/DOS window, type ping &lt;IP address of unit&gt; If you receive: Reply from &lt;IP address&gt;: bytes = 32; time = 10 ms..... - this means that the IP address may already be in use by another device on your network. You must obtain a new IP address and reinstall the unit. If you receive: Request timed out - this means that the IP address is available for use with your video server. In this case, check all cabling and reinstall the unit.</td>
</tr>
</tbody>
</table>

The AXIS 240Q cannot be accessed from a Web browser

<table>
<thead>
<tr>
<th>The IP address has been changed by DHCP</th>
<th>1) Move the AXIS 240Q to an isolated network or to one with no DHCP or BOOTP server. Set the IP address again, using the ARP Ping command. 2) Access the unit and disable BOOTP and DHCP in the TCP/IP settings. Return the unit to the main network. The unit now has a fixed IP address that will not change. 3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the required service and then configure IP address change notification from the network settings. Return the unit to the main network. The unit will now have a dynamic IP address, but will notify you if the address changes.</th>
</tr>
</thead>
</table>

Other networking problems

| Test the network cable by connecting it to another network device, then Ping that device from your workstation. See instructions above. |

Cannot send notifications, uploads, alarms, etc, to a destination outside the local network

<table>
<thead>
<tr>
<th>Firewall protection</th>
<th>The video server can be configured to use a SOCKS server to reach networks on the other side of a firewall/proxy server</th>
</tr>
</thead>
</table>

Your AXIS 240Q is accessible locally, but not externally

| Firewall protection | Check the Internet firewall with your system administrator. |
| Default routers required | Check if you need to configure the default router settings. |
| The Internet site is too heavily loaded | Use a script on your web server to relay images from the AXIS 240Q to the Internet. |

The Power indicator is not constantly lit

| Faulty power supply | Verify that you are using an AXIS PS-K power supply. |

The Status indicator is flashing red and the server is inaccessible

| A firmware upgrade has been interrupted or the firmware has been damaged in some other way. | A rescue firmware is running in the product. First, set the IP address using AXIS IP utility or ARP and Ping, see page 10. Then, using a browser, access the unit and download the latest firmware to the product, see Upgrading the Firmware, on page 48. |

No images displayed in the Web interface

| Problem with AMC (Internet Explorer only) | To enable the updating of images in Microsoft Internet Explorer, set your Web browser to allow ActiveX controls. Also, make sure that AXIS Media Control (AMC) component is installed on your workstation. |
| Installation of additional ActiveX component restricted or prohibited | Configure your AXIS 240Q to use a Java applet for updating the images under Live View Config > Layout > Default Viewer for Internet Explorer. See the online help for more information. |
### Video Image Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image too dark or too light.</td>
<td>Check that the termination dip switch for the video source is set to the correct position. See also the online help on Video Source Settings.</td>
</tr>
<tr>
<td>Black borders around the video image</td>
<td>Adjust the X and/or Y offset, in the Video Source Settings. See the online help for information.</td>
</tr>
<tr>
<td>Problems uploading own files</td>
<td>There is only limited space available for the upload of your own files. Try deleting one or more existing files, to free up space.</td>
</tr>
<tr>
<td>Missing images in uploads</td>
<td>This can occur when trying to use a larger image buffer than is actually available. Try lowering the frame rate or the upload period.</td>
</tr>
<tr>
<td>Slow image update</td>
<td>Configuring e.g. pre-buffers, motion detection, high resolution images, high frame rates, etc., will reduce the performance of the video server.</td>
</tr>
<tr>
<td>Slow performance</td>
<td>Slow performance may be caused by e.g. heavy network traffic, multiple users accessing the unit, low performance clients, use of features such as Motion Detection, Event handling, Image rotation.</td>
</tr>
</tbody>
</table>

### Bad snapshot images

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display incorrectly configured on your workstation</td>
<td>In Display Properties, configure your display to show at least 65000 colors, i.e. at least 16-bit. Using only 16 or 256 colors on your display will produce dithering artifacts in the image.</td>
</tr>
</tbody>
</table>

### Incorrect exposure in images

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incorrect line termination</td>
<td>If the AXIS 240Q is to be connected in loop through with other equipment, disable the input termination by turning the corresponding DIP switch to OFF.</td>
</tr>
</tbody>
</table>

For additional assistance, please contact your reseller or check the product’s support pages on the Axis Website at www.axis.com/techsup
## Technical Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Model</strong></td>
<td>• AXIS 240Q: Four port video server</td>
</tr>
<tr>
<td></td>
<td>• Also available as Video Rack Solution</td>
</tr>
<tr>
<td><strong>Video compression</strong></td>
<td>• Motion-JPEG.</td>
</tr>
<tr>
<td><strong>Resolutions</strong></td>
<td>• 4CIF, 2CIFExp, 2CIF, CIF, QCIF</td>
</tr>
<tr>
<td></td>
<td>• max 704x480 (NTSC) 704x576 (PAL)</td>
</tr>
<tr>
<td></td>
<td>• max 176x120 (NTSC) 176x144 (PAL)</td>
</tr>
<tr>
<td><strong>Frame rate</strong></td>
<td>• Up to 6/5 (NTSC/PAL) frames per second per channel</td>
</tr>
<tr>
<td><strong>Video streaming</strong></td>
<td>• Motion JPEG</td>
</tr>
<tr>
<td></td>
<td>• Controllable frame rate and bandwidth</td>
</tr>
<tr>
<td><strong>Image settings</strong></td>
<td>• Compression levels: 11</td>
</tr>
<tr>
<td></td>
<td>• Rotation: 90°, 180°, 270°</td>
</tr>
<tr>
<td></td>
<td>• Aspect ratio correction</td>
</tr>
<tr>
<td></td>
<td>• Color: Color, black 6 white</td>
</tr>
<tr>
<td></td>
<td>• Overlay capabilities: Time, date, text or image</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>• Multi-user password protection.</td>
</tr>
<tr>
<td></td>
<td>• IP address filtering.</td>
</tr>
<tr>
<td></td>
<td>• HTTPS (SSL/TLS) encryption.</td>
</tr>
<tr>
<td><strong>Users</strong></td>
<td>• 20 simultaneous users</td>
</tr>
<tr>
<td><strong>Pan/Tilt/Zoom</strong></td>
<td>• PTZ support for remote camera control. Please see <a href="http://www.axis.com">www.axis.com</a> for info</td>
</tr>
<tr>
<td></td>
<td>about supported devices.</td>
</tr>
<tr>
<td>**Terminal connector – I/O</td>
<td>• 4 digital alarm inputs</td>
</tr>
<tr>
<td>ports and connections</td>
<td>• 4 digital output transistors (max 24V, 0.1 A)</td>
</tr>
<tr>
<td></td>
<td>• RS-485 serial port</td>
</tr>
<tr>
<td></td>
<td>• Alternative power</td>
</tr>
<tr>
<td><strong>D-Sub connector</strong></td>
<td>• RS-232 serial port. Max 115 Kbit/s.</td>
</tr>
<tr>
<td><strong>Network connector</strong></td>
<td>• Ethernet 10BaseT/100BaseTX, connected via CAT 5 network cable to RJ-45</td>
</tr>
<tr>
<td></td>
<td>network socket.</td>
</tr>
<tr>
<td><strong>Processors and memory</strong></td>
<td>• ARTPEC-2 compression chip</td>
</tr>
<tr>
<td></td>
<td>• ETRAX-100 LX (32-bit RISC, 100MIPS CPU)</td>
</tr>
<tr>
<td></td>
<td>• 32 MB RAM</td>
</tr>
<tr>
<td></td>
<td>• 8 MB Flash memory</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td>• External AXIS PS-K Power adapter (included), 9V DC, 9W.</td>
</tr>
<tr>
<td></td>
<td>• Alternative power connection via terminal connector; 7-20V DC, max 7W.</td>
</tr>
<tr>
<td><strong>Operating Conditions</strong></td>
<td>• Temp: 5°C (41°F) to 50°C (122°F).</td>
</tr>
<tr>
<td></td>
<td>• Humidity: 20-80% RH (non-condensing).</td>
</tr>
<tr>
<td><strong>Minimum web browsing</strong></td>
<td>• Pentium III CPU 500 MHz or higher, or equivalent AMD.</td>
</tr>
<tr>
<td>requirements</td>
<td>• 128 MB RAM</td>
</tr>
<tr>
<td></td>
<td>• AGP graphic card, Direct Draw, 32 MB RAM</td>
</tr>
<tr>
<td></td>
<td>• Windows XP, 2000, NT4.0, ME or 98.</td>
</tr>
<tr>
<td></td>
<td>• DirectX 9.0 or later</td>
</tr>
<tr>
<td></td>
<td>• Internet Explorer 6.x or later.</td>
</tr>
<tr>
<td></td>
<td>• For other operating systems and browsers, please see <a href="http://www.axis.com/techsup">www.axis.com/techsup</a></td>
</tr>
</tbody>
</table>
### Supported protocols
- Motion JPEG streaming: HTTP.
- Event notification: HTTP, TCP, SMTP.
- Image upload: FTP, SMTP, HTTP.
- Network control data: DHCP, UPnP, ARP, DNS, DynDNS3, NAT traversal, SOCKS, SNMP, NTP Security: SSL/TLS*, HTTPS.
- This product includes software developed by the Open SSL Project for use in the Open SSL Tool kit (www.openssl.org).

### Approvals – EMC
- CE compliant according to:
  - EN550022/1998 Class B
  - EN550024/1998
  - EN61000-3-2:2000
  - EN61000-3-3:2000
- FCC Subpart B, Class A, B
- VCCI Class B
- C-tick AS/NZS 3548
- Canadian ICES-003 B by compliance with EN55022/1998 Class B

### Approvals – Safety
- EN60950, UL, CSA (power adapter only)

### Video Inputs
- 4 BNC composite video inputs with 75 Ohm/Hi Z termination, including autosensing for NTSC and PAL.

### Management
- Remote configuration and status using web-based setup tools.

### Pre/Post Alarm Buffer
- Up to 3MB memory available per video source for pre/post alarm image storage.

### Dimensions
- Height: 1.7 (4.2 cm)
- Width: 5.5 (14.0 cm)
- Length: 6.1 (15.5 cm)
- Weight: 1.2 lb. (0.54 kg) power adapter not included

### Complimentary Software
- AXIS Media Control (AMC) – ActiveX component software required for Microsoft Internet Explorer - installed automatically on first use.
- Optional: AXIS IP Utility – For Windows installation.
General performance considerations

When setting up your system, it is important to consider how various settings and situations will affect performance. Some factors affect the amount of bandwidth (the bit rate) required, others can affect the frame rate, and some will affect both. If the load on the CPU reaches its maximum, this will also affect the frame rate.

The following factors are among the most important to consider:

- High image resolutions and/or lower compression levels result in larger images. Bandwidth affected.
- Access by large numbers of Motion JPEG clients. Bandwidth affected.
- Video channels - The number of video channels simultaneously accessed by clients affects the video server’s CPU and video compression load.
- Simultaneous viewing of different streams (resolution, compression, etc.) by different clients. Frame rate and bandwidth affected.
- Heavy usage of event settings affects the CPU load. Frame rate affected.
- Enabled motion detection. Frame rate and bandwidth affected.
- HTTPS - Increases the server's CPU load when encrypting data.
- Heavy network utilization due to poor infrastructure. Bandwidth affected.
- Poorly performing client PC - Lowers perceived performance.

Optimizing your system

To see the bandwidth and frame rate currently required by the video stream, the AXIS 240Q provides a tool that can be used to display these values directly in the video image.

To do this, special format strings are added as part of a text overlay. Simply add \#r (average frame rate in fps) and/or \#b (average bandwidth in Kbps) to the overlay.

For detailed instructions, please see the online help for Video & Image > Overlay Settings, and the help for File Naming & Date/Time Formats.

Important!

- The figures displayed here are the values as delivered by the server. If other restrictions are currently in force, (e.g. bandwidth limitation) these values might not correspond to those actually received by the client.
- For Motion JPEG, these values will only be accurate as long as no frame rate limit has been specified.
Frame rates - Motion JPEG
The AXIS 240Q has a frame rate of up to 6/5 fps per channel for all resolutions.

Bandwidth
As there are many factors affecting bandwidth, it is very difficult to predict the required amounts. The settings that affect bandwidth are:

- the image resolution
- the image compression
- the frame rate
- the analog cameras connected to the video server

There are also factors in the monitored scene that will affect the bandwidth. These are:

- the amount of motion
- the image’s complexity
- the lighting conditions.
Glossary

Active Speaker - a speaker with a built-in power amplifier.

ActiveX - ActiveX is a standard that enables software components to interact with one another in a networked environment, regardless of the language(s) used to create them. Web browsers may come into contact with ActiveX controls, ActiveX documents, and ActiveX scripts. ActiveX controls are often downloaded and installed automatically as required.

AF (Autofocus) - A system by which the camera lens automatically focuses on a selected part of the subject.

AMC (AXIS Media Control) - AMC is the ActiveX component required to view moving images from an Axis video device in Internet Explorer. The component is installed automatically on the viewing computer on first use. Once installed, AMC can be configured from Windows Control Panel.

Analog video camera - The signal from an analog video camera is viewed directly on e.g. a monitor in the analog system, which depends on traditional analog cabling. Alternatively, the signal can be digitized with the use of a video server, and can then be made available over a data (IP) network.

Angle - The field of view, relative to a standard lens in a 35mm still camera, expressed in degrees, e.g. 30°. For practical purposes, this is the area that a lens can cover, where the angle of view is determined by the focal length of the lens. A wide-angle lens has a short focal length and covers a wider angle of view than standard or telephoto lenses, which have longer focal lengths.

API (Application Programming Interface) - An API is a set of routines, protocols, and tools for building software applications. A good API makes it easier to develop a program by providing all the required building blocks. The Axis VAPIX API allows Axis products to be integrated into other applications.

ARP (Address Resolution Protocol) - This protocol is used to associate an IP address to a hardware MAC address. A request is broadcast on the local network to discover the MAC address for an IP address.

ARTPEC (Axis Real Time Picture Encoder) - A chip designed by Axis for image compression. ARTPEC supports a range of CCD and CMOS sensors, built-in functionality for sharpening, backlight compensation, noise reduction and white balance, support for multiple Motion-JPEG streams, support for MPEG-4 part 2, up to 30 frames/second from 4 simultaneous video sources and real-time compression of up to 45 Megapixels/second.

ASIC (Application Specific Integrated Circuit) - A circuit designed for a specific application, as opposed to a general purpose circuit, such as a microprocessor.

Aspect ratio - A ratio of width to height in images. A common aspect ratio used for television screens and computer monitors is 4:3. High-definition television (HDTV) uses an aspect ratio of 9:16.

Autoiris (DC-Iris) - This special type of iris is electrically controlled by the camera, to automatically regulate the amount of light allowed to enter.

AVI (Audio Video Interleave) - A video format that supports simultaneous playback of audio and video.

AXIS Internet Dynamic DNS Service - This free service provides an Axis network product with a unique DNS or domain name (URL address), which can then be used instead of an IP address to access the product from a web browser.

AXIS IP Utility - A tool for discovering and setting IP addresses for Axis network devices. AXIS IP Utility is supplied free of charge by Axis.

AXIS Camera Management - A powerful and efficient installation and management tool for Axis network video products. The tool can automatically find and set IP addresses, show connection status and manage firmware upgrades of multiple devices.

Bitmap - A bitmap is a data file representing a rectangular grid of pixels. It defines a display space and color for each pixel (or "bit") in the display space. This type of image is known as a "raster graphic." GIF's and JPEG's are examples of image file types that contain bitmaps. Because a bitmap uses this fixed raster method, it cannot easily be rescaled without losing definition. Conversely, a vector graphic image uses geometrical shapes to represent the image, and can thus be quickly rescaled.

Bit rate - The bit rate (in kbit/s or Mbit/s) is often referred to as speed, but actually defines the number of bits/time unit and not distance/time unit.

Bluetooth - Bluetooth is an open standard for wireless transmission of voice and data between mobile devices (PCs, handheld computers, telephones and printers).

Bonjour - Also known as zero-configuration networking. Bonjour enables the automatic discovery of computers, devices, and services on IP networks. Bonjour allows devices to automatically discover each other without the need to enter IP addresses or configure DNS servers. Bonjour is developed by Apple Computer Inc.

BOOTP (Bootstrap Protocol) - A protocol that can automatically configure a network device (give it an IP address). BOOTP is the basis for a more advanced network management protocol, the Dynamic Host Configuration Protocol (DHCP).

Broadband - In network engineering terms, this describes transmission methods where two or more signals share the same carrier. In more popular terminology, broadband is taken to mean high-speed data transmission.
CCTV (Closed Circuit Television) - A CCTV system is a closed/private video system, usually constructed with coaxial cabling, and used within a single building/group of buildings. It is used to visually monitor the location for security or industrial purposes. Video from the CCTV system can be recorded and viewed on-site or remotely.

CCTV video camera - A traditional CCTV video camera is an analog camera, available in both monochrome (black and white) and color. Cameras can be set in fixed positions or placed on "Pan/Tilt/Zoom" devices, which allow the camera to be maneuvered. Using a zoom lens provides a closer view of the object being viewed. CCTV analog video cameras can be viewed over a computer network by using a video server.

CIF (Common Intermediate Format) - CIF refers to the analog video resolutions 352x288 pixels (PAL) and 352x240 pixels (NTSC). See also Resolution.

Client-server - Client-server describes the relationship between two computer programs in which one program, the client, makes a service request from another program, the server, which fulfills the request. Typically, multiple client programs share the services of a common server program. A web browser is a client program that requests services (the sending of web pages or files) from a web server.

CMOS (Complementary Metal Oxide Semiconductor) - A CMOS is a widely used type of semiconductor that uses both negative and positive circuits. Since only one of the circuit types is on at any given time, CMOS chips require less power than chips using just one type of transistor. CMOS image sensors also allow processing circuits to be included on the same chip, an advantage not possible with CCD sensors, which are also much more expensive to produce.

Coaxial cable - Coaxial cable is the standard means of transmitting analog video in a CCTV system. Coaxial is also used by cable companies to distribute television in residential buildings.

Codec - In communications engineering, a codec is usually a coder/decoder. Codecs are used in integrated circuits or chips that convert e.g. analog video and audio signals into a digital format for transmission. The codec also converts received digital signals back into analog format. A codec uses analog-to-digital conversion and digital-to-analog conversion in the same chip.

Codec can also mean compression/decompression, in which case it is generally taken to mean an algorithm or computer program for reducing the size of large files and programs.

Composite video - A type of video signal in which the red, blue and green signals (sometimes audio signals too) are mixed together.

Compression - See Image Compression.

Contrast - Defines the degree of difference between the lightest and darkest parts of an image or video stream.

Control unit - If a CCTV system has more than one camera, there must be a way to control the video signals going to recorders and monitors. There are three basic types of Video Control Unit: Multiplexer, Switch and Quad.

dB (Decibels) - A unit to measure sound level changes. A 3dB change is the smallest level change we can hear. A 3dB change is actually twice or half the audio power level. A gain of 0dB will leave the signal level unchanged.

DC-Iris - This special type of iris is electrically controlled by the camera, to automatically regulate the amount of light allowed to enter.

Decoder - See video decoder.

De-interlacing - See interlacing.

DHCP (Dynamic Host Configuration Protocol) - DHCP is a protocol that lets network administrators automate and centrally manage the assignment of Internet Protocol (IP) addresses to network devices in a network. DHCP uses the concept of a "lease" or amount of time that a given IP address will be valid for a computer. The lease time can vary, depending on how long a user is likely to require the network connection at a particular location. DHCP also supports static addresses for e.g. computers running web servers, which need a permanent IP address.

DNS (Domain Name System) - DNS is used to locate and translate Internet domain names into IP (Internet Protocol) addresses. A domain name is a meaningful and easy-to-remember name for an Internet address. For example the domain name www.example.com is much easier to remember than 192.0.34.166. The translation tables for domain names are contained in Domain name servers.

Domain server - Domains can also be used by organizations that wish to centralize the management of their (Windows) computers. Each user within a domain has an account that usually allows them to log in to and use any computer in the domain, although restrictions may also apply. The domain server is the server that authenticates the users on the network.
Dome network camera - A remotely controllable camera mounted in a special housing, characterized by the dome shaped glass or plastic covering behind which the camera resides. Usually mounted on a ceiling and looking downwards, a dome camera can often rotate up to 360 degrees, thus providing excellent coverage of large areas.

Duplex - See Full-duplex.

DVD (Digital Versatile Disc) - An optic disc with the same physical size as a CD, but with significantly greater storage capacity.

DVR (Digital Video Recorder) - A DVR records analog video to a hard disk in digital format. Most DVR’s use the MPEG-2 format for encoding analog video signals.

Encoder - See Video encoder.

Ethernet - Ethernet is one of the most widely installed local area network technology. An Ethernet LAN typically uses special grades of twisted pair wires. The most commonly installed Ethernet systems are 10BASE-T and 100BASE-T10, which provide transmission speeds up to 10 Mbps and 100 Mbps respectively.

ETRAX (Ethernet Token Ring AXIS) - The ETRAX chip is the cornerstone of Axis technology and the ‘brain’ in nearly all Axis products. A multipurpose Linux chip with integrated Ethernet networking and extremely flexible I/O options.

Factory default settings - These are the settings that originally applied for a device when it was first delivered from the factory. If it should become necessary to reset a device to its factory default settings, this will, for many devices, completely reset any settings that were changed by the user.

Firewall - A firewall works as a barrier between networks, e.g. between a Local Area Network and the Internet. The firewall ensures that only authorized users are allowed to access the one network from the other. A firewall can be software running on a computer, or it can be a standalone hardware device.

Fixed dome network camera - This type of camera cannot be remotely controlled as regards movement, but is mounted in the same type of dome as a controllable network dome camera. This camera must be positioned manually to provide the required coverage.

Fixed network camera - This type of camera cannot be remotely controlled as regards movement. It must be positioned manually to provide the required coverage.

Fixed iris - See Autoiris.

Focal length - Measured in millimeters, the focal length of a camera lens determines the width of the horizontal field of view, which in turn is measured in degrees.

FTP (File Transfer Protocol) - FTP is an application protocol that uses the TCP/IP protocols, used to exchange files between computers/devices on networks.

Frame - A frame is a complete video image. In the 2:1 interlaced scanning format of the RS-170 and CCIR formats, a frame is made up of two separate fields of 262.5 or 312.5 lines interlaced at 60 or 50 Hz to form a complete frame, which appears at 30 or 25 Hz. In video cameras with a progressive scan, each frame is scanned line-by-line and not interlaced; most are also displayed at 30 and 25 Hz.

Frame rate - The frame rate used to describe the frequency at which a video stream is updated is measured in frames per second (fps). A higher frame rate is advantageous when there is movement in the video stream, as it maintains image quality throughout.

Full-duplex - Transmission of data in two directions simultaneously. In an audio system this would describe e.g. a telephone systems. Half-duplex also provides bi-directional communication, but only in one direction at a time, as in a walkie-talkie system. See also Simplex.

G.711 - The international standard for encoding telephone audio on a 64 kbps channel. It is a pulse code modulation (PCM) scheme operating at 8 kHz sample rate.

G.726 - A frequently used speech-compression algorithm in telecommunications due to its high perceived speech quality and low resource requirements.

Gain - Gain is the amplification factor and the extent to which an analog amplifier boosts the strength of a signal. Amplification factors are usually expressed in terms of power. The decibel (dB) is the most common way of quantifying the gain of an amplifier.

Gateway - A gateway is a point in a network that acts as an entry point to another network. In a corporate network for example, a computer server acting as a gateway often also acts as a proxy server and a firewall server. A gateway is often associated with both a router, which knows where to direct a given packet of data that arrives at the gateway, and a switch, which furnishes the actual path in and out of the gateway for a given packet.

GIF (Graphics Interchange Format) - GIF is one of the most common file formats used for images in web pages. There are two versions of the format, 87a and 89a. Version 89a supports animations, i.e. a short sequence of images within a single GIF file. A GIF89a can also be specified for interlaced presentation.

GOV (Group Of VOPs) - A group of VOP’s is the basic unit of an MPEG-4 video stream. The GOV contains different types and numbers of VOP’s (I-VOP’s, P-VOP’s, etc) as determined by the GOV length and GOV structure. See also VOP.

GOV length - The GOV length determines the number of images (VOP’s) in the GOV structure. See also GOV and VOP.

GOV structure - The GOV structure describes the composition of an MPEG-4 video stream, as regards the...
type of images (I-VOP’s or P-VOP’s) included in the stream, and their internal order. See also GOV and VOP.

**Half-duplex** - See *Full-duplex*.

**HTML (Hypertext Markup Language)** - HTML is the set of “markup” symbols or codes inserted in a file intended for display in a web browser. The markup tells the browser how to display the page’s words and images for the user.

**HTTP (Hypertext Transfer Protocol)** - HTTP is the set of rules for exchanging files (text, graphic images, sound, video, and other multimedia files) on the web. The HTTP protocol runs on top of the TCP/IP suite of protocols.

**HTTPS (Hypertext Transfer Protocol over SSL)** - HTTPS is a protocol used by web browsers and servers to encrypt and decrypt user page requests and the pages returned by the server. The encrypted exchange of information is governed by the use of an HTTPS certificate (issued by a Certificate Authority), which guarantees the authenticity of the server.

**Hub** - A (network) hub is used to connect multiple devices to the network. The hub transmits all data to all devices connected to it, whereas a switch will only transmit the data to the device it is specifically intended for.

**IEEE 802.11** - A family of standards for wireless LANs. The 802.11a standard supports 1 or 2 Mbit/s transmission on the 5 GHz band. IEEE 802.11b supports data rates up to 11 Mbit/s on the 2.4 GHz band, while 802.11g allows up to 54 Mbit/s on the 2.4 GHz band.

**Image compression** - Image compression minimizes the file size (in bytes) of an image. Two of the most common compressed image formats are JPEG and GIF. See also *MPEG* and *Motion JPEG*.

**Interlacing** - Interlaced video is video captured at 50 pictures (known as fields) per second, of which every 2 consecutive fields (at half height) are then combined into 1 frame. Interlacing was developed many years ago for the analog TV world and is still used widely today. It provides good results when viewing motion in standard TV pictures, although there is always some degree of distortion in the image.

To view interlaced video on e.g. a computer monitor, the video must first be de-interlaced, to produce progressive video, which consists of complete images, one after the other, at 25 frames per second. See also *Progressive scan*.

**IP (Internet Protocol)** - The Internet Protocol is a method transmitting data over a network. Data to be sent is divided into individual and completely independent “packets.” Each computer (or host) on the Internet has at least one address that uniquely identifies it from all others, and each data packet contains both the sender’s address and the receiver’s address.

The Internet Protocol ensures that the data packets all arrive at the intended address. As IP is a connectionless protocol, which means that there is no established connection between the communication end-points, packets can be sent via different routes and do not need to arrive at the destination in the correct order.

Once the data packets have arrived at the correct destination, another protocol - Transmission Control Protocol (TCP) - puts them in the right order. See also *TCP*.

**IP address** - An IP address is simply an address on an IP network used by a computer/device connected to that network. IP addresses allow all the connected computers/devices to find each other and to pass data back and forth.

To avoid conflicts, each IP address on any given network must be unique. An IP address can be assigned as fixed, so that it does not change, or it can be assigned dynamically (and automatically) by DHCP.

An IP address consists of four groups (or quads) of decimal digits separated by periods, e.g. 130.5.5.25. Different parts of the address represent different things. Some part will represent the network number or address, and some other part will represent the local machine address. See also *IP (Internet Protocol)*.

**Infrared (IR)** - Infrared radiation is radiation at a longer wavelength than visible light, which means it cannot be seen by the naked human eye. As infrared radiation can be detected as heat, this can be shown on a screen or captured by a digital camera, with hotter objects showing up brighter against colder surroundings (e.g. a human body against a colder background).

As color cameras can “see” infrared radiation as well as visible light, these cameras are equipped with an IR-cut filter, to prevent distortion of the colors the human eye can see. To use the camera in very dark locations or at night, this filter can be removed, to allow infrared radiation to hit the image sensor and thus produce images. An infrared lamp can be used for improved illumination for night surveillance, while not producing any extra visible light.

**Inputs/Outputs (I/O’s)** - The digital I/Os on, for example, a network camera can be used to connect any device that can toggle between an open and a closed circuit.

For example, if a door switch is used as an input device, opening the door could trigger the upload of video images and the sending of notification messages.

An output might, for example, be used to automatically start a siren when there is a motion detection trigger.

**ISMA (Internet Streaming Media Alliance)** - ISMA’s goal is: “To accelerate the adoption and deployment of open standards for streaming rich media content such as video, audio, and associated data, over Internet protocols.”

**I-VOP** - See *VOP*. 
JPEG (Joint Photographic Experts Group) - Together with the GIF file format, JPEG is an image file type commonly used on the web. A JPEG image is a bitmap, and usually has the file suffix '.jpg' or '.jpeg.' When creating a JPEG image, it is possible to configure the level of compression to use. As the lowest compression (i.e. the highest quality) results in the largest file, there is a trade-off between image quality and file size.

kbit/s (kilobits per second) - A measure of the bit rate, i.e. the rate at which bits are passing a given point. See also Bit rate.

LAN (Local Area Network) - A LAN is a group of computers and associated devices that typically share common resources within a limited geographical area.

Linux - Linux is an open source operating system within the Unix family. Because of its robustness and availability, Linux has won popularity in the open source community and among commercial application developers.

Lux - A standard unit of illumination measurement.

MAC address (Media Access Control address) - A MAC address is a unique identifier associated with a piece of networking equipment, or more specifically, its interface with the network. For example, the network card in a computer has its own MAC address.

Manual iris - This is the opposite of an autoiris, i.e. the camera iris must be adjusted manually to regulate the amount of light allowed to reach the image sensor.

Mbit/s (Megabits per second) - A measure of the bit rate, i.e. the rate at which bits are passing a given point. Commonly used to give the "speed" of a network. A LAN might run at 10 or 100 Mbit/s. See also Bit rate.

Monitor - A monitor is very similar to a television set, but lacks the electronics to pick up regular television signals.

Motion JPEG - Motion JPEG is a simple compression/decompression technique for network video. Latency is low and image quality is guaranteed, regardless of movement or complexity of the image. Image quality is controlled by adjusting the compression level, which in turn provides control over the file size, and thereby the bit rate.

High-quality individual images from the Motion JPEG stream are easily extracted. See also JPEG and GIF.

Megapixel - See Pixel.

MPEG (Moving Picture Experts Group) - The Moving Picture Experts Group develops standards for digital video and audio compression. It operates under the auspices of the International Organization for Standardization (ISO). The MPEG standards are an evolving series, each designed for a different purpose.

MPEG-2 - The designation for a group of audio and video coding standards, and is typically used to encode audio and video for broadcast signals, including digital satellite and Cable TV. MPEG-2, with some modifications, is also the coding format used by standard commercial DVD movies.

MPEG-4 - MPEG-4 is a group of audio and video coding standards and related technology. The primary uses for the MPEG-4 standard are web (streaming media) and CD distribution, conversational (videophone), and broadcast television.

Most of the features included in MPEG-4 are left to individual developers to decide whether to implement them or not. This means that there are probably no complete implementations of the entire MPEG-4 set of standards. To deal with this, the standard includes the concept of "profiles" and "levels", allowing a specific set of capabilities to be defined in a manner appropriate for a subset of applications.

Multicast - Bandwidth-conserving technology that reduces bandwidth usage by simultaneously delivering a single stream of information to multiple network recipients. See also Unicast.

Multiplexer - A multiplexer is a high-speed switch that provides full-screen images from up to 16 analog cameras. Multiplexers can playback everything that happened on any one camera with no interference from the other cameras on the system.

Network camera (Network video camera) - A network camera is a camera and computer combined in one intelligent unit. It captures and sends live video directly over an IP network such as a LAN, intranet or the Internet. Users can view and/or manage the camera using a standard web browser or application software from any local or remote computer on a network. The camera allows multiple authorized viewers from different locations to simultaneously access images. A network camera is sometimes known as an IP camera.

Network connectivity - The physical (wired or wireless) and logical (protocol) connection of a computer network or an individual device to a network, such as the Internet or a LAN.

Network video - Network video (often referred to as IP-Surveillance for specific applications within security surveillance and remote monitoring) is a system that gives users the ability to monitor and record video over an IP network (LAN/WAN/Internet).

NTSC (National Television System Committee) - NTSC is an analog color encoding system used in television systems in Japan, the United States and other parts of the Americas. NTSC defines the video signal using 525 TV lines per frame, at a refresh rate equal to 30 frames per second. See also PAL.
NVR (Network Video Recorder) - A dedicated Network Video Recorder (NVR) can be used to gather data streams from remote network cameras and video servers and store them on a hard disk. An NVR can be a stand-alone networked PC, or a dedicated video recording hard disk server with its own software application.

OEM (Original Equipment Manufacturer) - This is a designation for companies that manufacture equipment that is then marketed and sold to other companies under their own names.

PAL (Phase Alternating Line) - PAL is an analog color encoding system used in television systems in Europe and in many other parts of the world. PAL defines the video signal using 625 TV lines per frame, at a refresh rate equal to 25 frames per second. See also NTSC.

PDA (Personal Digital Assistant) - A small handheld computer, which usually provides at least a calendar, an organizer and a notepad.

PEM (Privacy Enhanced Mail) - An early standard for securing electronic mail. The PEM-format is often used for representing an HTTPS certificate or certificate request.

Ping - Ping is a basic network program used diagnostically to check the status of a network host or device. Ping can be used to see if a particular network address (IP address or host name) is occupied or not, or if the host at that address is responding normally. Ping can be run from e.g. the Windows Command prompt or the command line in Unix.

Pixel (Picture Element) - A pixel is one of the many tiny dots that make up a digital image. The color and intensity of each pixel represents a tiny area of the complete image.

PoE (Power over Ethernet) - Power over Ethernet provides power to a network device via the same cable as used for the network connection. This is very useful for IP-Surveillance and remote monitoring applications in places where it may be too impractical or expensive to provide power to a network device via the power outlet.

PPP (Point-to-Point Protocol) - A protocol that uses a serial interface for communication between two network devices. For example, a PC connected by a phone line to a remote modem, both locally and remotely. Application examples include traffic and production line monitoring, and the monitoring of multiple store locations.

PTZ (Pan Tilt Zoom) - A PTZ-enabled camera can be remotely controlled so as to change the view from the camera. Panning is the movement of the camera along its horizontal axis, tilting is the movement of the camera along its vertical axis, and zooming is the adjustment of the zoom lens to magnify the view.

Quad view - A Quad view displays images from up to four cameras on a single screen; where the images from each camera take up approximately a quarter of the display area.

Remote monitoring - Network video gives users the ability to gather information at all key points of an operation and view it in real time. This makes the technology ideal for monitoring equipment, people and places, both locally and remotely. Application examples include traffic and production line monitoring, and the monitoring of multiple store locations.

Resolution - Image resolution is a measure of how much detail a digital image can hold: the greater the resolution, the greater the level of detail. Resolution can be specified as the number of pixel-columns (width) by the number of pixel-rows (height), e.g. 320x240. Alternatively, the total number of pixels (usually in megapixels) in the image can be used. In analog systems, it is also common to use other format designations, such as CIF, QCIF, 4CIF, etc.
RS-232 - A long-established standard that describes the physical interface and protocol for low-speed serial data communication between devices. This is the interface that e.g. a computer uses to talk to and exchange data with a modem and other serial devices.

RS-422 - A serial data communication protocol that specifies 4-wire, full-duplex, differential line, multi-drop communications. It provides balanced data transmission with unidirectional/non-reversible, terminated or non-terminated transmission lines. RS-422 does not allow multiple drivers, only multiple receivers. Maximum recommended range is 4,000 feet (1200 meters). Maximum recommended baud rate is 10Mbit/s.

RS-485 - An upgraded version of RS-422 that supports up to 32 devices on the same connection. RS-485 is an electrical specification of a two-wire, half-duplex, multipoint serial connection. It enables the configuration of inexpensive local networks and multidrop communications links. It offers high data transmission speeds (up to 10Mbit/s), and as it uses a differential balanced line over twisted pair (like RS-422), it can span relatively large distances (4000 feet or 1200 meters). RS-485 only specifies the electrical characteristics of the driver and the receiver. It does not specify or recommend any data protocol.

RTCP (Real-Time Control Protocol) - RTCP provides support for real-time conferencing of groups of any size within an intranet. This support includes source identification and support for gateways like audio and video bridges as well as multicast-to-unicast translators. It offers quality-of-service feedback from receivers to the multicast group as well as support for the synchronization of different media streams.

RTP (Real-Time Transport Protocol) - An Internet protocol for the transport of real-time data, e.g. audio and video. It can be used for media-on-demand as well as interactive services such as Internet telephony.

RTSP (Real Time Streaming Protocol) - A control protocol, and a starting point for negotiating transports such as RTP, multicast and Unicast, and for negotiating codecs. RTSP can be considered a "remote control" for controlling the media stream delivered by a media server. RTSP servers typically use RTP as the protocol for the actual transport of audio/video data.

Router - A device that determines the next network point to which a packet should be forwarded on its way to its final destination. A router creates and/or maintains a special routing table that stores information on how best to reach certain destinations. A router is sometimes included as part of a network switch. See also Switch.

Security surveillance - Network video’s advanced functionality makes it highly suited to the applications involved in security surveillance. The flexibility of digital technology enhances security personnel’s ability to protect people, property and assets. Such systems are therefore an especially attractive option for companies currently using CCTV.

Server - In general, a server is a computer program that provides services to other computer programs in the same or other computers. A computer running a server program is also frequently referred to as a server. In practice, the server may contain any number of server and client programs. A web server is the computer program that supplies the requested HTML pages or files to the client (web browser).

Sharpness - This is the control of fine detail within a picture. This feature was originally introduced into color TV sets that used notch filter decoders. This filter took away all high frequency detail in the black and white region of the picture. The sharpness control attempted to put some of that detail back in the picture. Sharpness controls are mostly superfluous in today’s high-end TVs. The only logical requirement for it nowadays is on a VHS machine.

Simplex - In simplex operation, a network cable or communications channel can only send information in one direction. See also Full-duplex.

SMTP (Simple Mail Transfer Protocol) - Used for sending and receiving e-mail. However, as it is "simple," it is limited in its ability to queue messages at the receiving end, and is usually used with one of two other protocols, POP3 or IMAP. These other protocols allow the user to save messages in a server mailbox and download them periodically from the server.

SMTP authentication - An extension of SMTP, where the client is required to log into the mail server before or during the sending of email. It can be used to allow legitimate users to send email while denying the service to unauthorized users, such as spammers.

SNMP (Simple Network Management Protocol) - SNMP forms part of the Internet Protocol suite, as defined by the Internet Engineering Task Force. The protocol can support monitoring of network-attached devices for any conditions that warrant administrative attention.

Sockets - Sockets are a method for communication between a client program and a server program over a network. A socket is defined as "the endpoint in a connection." Sockets are created and used with a set of programming requests or "function calls" sometimes called the sockets application programming interface (API).

SSL/TLS (Secure Socket Layer/Transport Layer Security) - These two protocols (SSL is succeeded by TSL) are cryptographic protocols that provide secure communication on a network. SSL is commonly used over HTTP to form HTTPS, as used e.g. on the Internet for electronic financial transactions. SSL uses public key certificates to verify the
identity of the server.

Subnet & subnet mask - A subnet is an identifiably separate part of an organization’s network. Typically, a subnet may represent all the machines at one geographic location, in one building, or on the same local area network (LAN). Having an organization’s network divided into subnets allows it to be connected to the Internet with a single shared network address.

The subnet mask is the part of the IP address that tells a network router how to find the subnet that the data packet should be delivered to. Using a subnet mask saves the router having to handle the entire 32-bit IP address; it simply looks at the bits selected by the mask.

Switch - A network device that connects network segments together, and which selects a path for sending a unit of data to its next destination. In general, a switch is a simpler and faster mechanism than a router, which requires knowledge about the network and how to determine the route. Some switches include the router function. See also Router.

TCP (Transmission Control Protocol) - TCP is used along with the Internet Protocol (IP) to transmit data as packets between computers over the network. While IP takes care of the actual packet delivery, TCP keeps track of the individual packets that the communication (e.g. requested a web page file) is divided into, and, when all packets have arrived at their destination, it reassembles them to re-form the complete file.

TCP is a connection-oriented protocol, which means that a connection is established between the two end-points and is maintained until the data has been successfully exchanged between the communicating applications.

Telnet - Telnet is a simple method with which to access another network device, e.g. a computer. The HTTP protocol and the FTP protocols allow you to request specific files from remote computers, but do not allow you logon as a user of that computer. With Telnet, you log on as a regular user with whatever privileges you may have been granted for specific applications and data residing on that computer.

Time-lapse recorder - This type of video recorder is commonly used in the security industry and has the ability to record up to one week of video on a single tape. The most commonly used timing is the 24-hour mode. Having to change tapes only once a day and retaining large amounts of information are perceived as key advantages in using this particular mode of recording.

TVL (TV Lines) - A method of defining resolutions in analog video.

UDP (User Datagram Protocol) - UDP is a communications protocol that offers limited service for exchanging data in a network that uses the Internet Protocol (IP). UDP is an alternative to the Transmission Control Protocol (TCP). The advantage of UDP is that it is not required to deliver all data and may drop network packets when there is e.g. network congestion. This is suitable for live video, as there is no point in re-transmitting old information that will not be displayed anyway.

Unicast - Communication between a single sender and a single receiver over a network. A new connection is established for each new user. See also Multicast.

UPnP™ - A set of computer network protocols that allows the automatic peer-to-peer detection of devices on the network. UPnP is promoted by the UPnP Forum.

URL (Uniform Resource Locator) - An "address" on the network.

USB (Universal Serial Bus) - A plug-and-play interface between a computer and peripheral devices (scanners, printers etc)

Varifocal lens - A lens that provides a wide range of focal lengths, as opposed to a lens with a fixed focal length, which only provides one.

Video camera - See Network camera and CCTV video camera.

Video decoder - A network video decoder converts digital video and audio streams back into analog signals, which can then be displayed on standard TV sets, analog monitors and video switches.

Video encoder (video server) - A video encoder/server digitizes analog video signals and sends digital images directly over an IP network, such as a LAN, intranet or the Internet. In effect, it turns an analog video system into a network video system and enables users to view live images using a web browser or application software on any local or remote computer on a network.

Video management software - Video management software supplies the means for monitoring, analyzing and recording network video. In its simplest form, it offers live viewing, storage and retrieval of video sequences. Advanced applications may also provide support for recording of live video from multiple devices, different recording modes, search functions, remote access via a web browser, control of PTZ devices, etc.

VMD (Video Motion Detection) - Video Motion detection defines activity (motion) in a monitored scene by analyzing image data and differences in series of images. This detection can, for example, be used to trigger an alarm event in a network camera and start the upload of images from the camera.

Video switcher - An analog video switcher sequentially displays full screen images, from one camera after another, typically at 3–5 seconds intervals. Other camera sources are not recorded while the image source from one camera is displayed on screen.
VPN (Virtual Private Network) - This creates a secure "tunnel" between the points within the VPN. Only devices with the correct "key" will be able to work within the VPN. The VPN network can be within a company LAN (Local Area Network), but different sites can also be connected over the Internet in a secure way. One common use for VPN is for connecting a remote computer to the corporate network, via e.g. a direct phone line or via the Internet.

VOP (Video Object Plane) - A VOP is an image frame in an MPEG-4 video stream. There are several types of VOP:
- An I-VOP is a complete image frame.
- An P-VOP codes the differences between images, as long as it is more efficient to do so. Otherwise it codes the whole image, which may also be a completely new image.

WAN (Wide-Area-Network) - Similar to a LAN, but on a larger geographical scale.

W-LAN (Wireless LAN) - A wireless local area network that uses radio waves as its carrier: where the network connections for end-users are wireless. The main network structure usually uses cables.

Web camera (Webcam) - A camera that requires a constant connection (via e.g. USB) to a PC for its operation. See also Network camera.

Web server - A program that allows web browsers to retrieve files from computers connected to the Internet. The Web server listens for requests from browsers and upon receiving a request for a file sends it back to the browser. The primary function of a Web server is to serve pages to other remote computers.

WEP (Wireless Equivalent Privacy) - A wireless security protocol, specified in the IEEE 802.11 standard, which is designed to provide a wireless local area network (WLAN) with a level of security and privacy comparable to that usually expected of a wired LAN. Security is at two different levels; 40-bit and 128-bit encryption. The higher the bit number, the more secure the encryption.

WINS (Windows Internet Naming Service) - Part of the Microsoft Windows NT Server, WINS manages the association of workstation names and locations with IP addresses, without the user or administrator having to be involved in each configuration change.

WPA-PSK (Wi-Fi Protected Access - Pre-Shared Key) - This wireless encryption method uses a pre-shared key (PSK) for key management. Keys can usually be entered as manual hex values, as hexadecimal characters, or as a Passphrase. WPA-PSK provides a greater degree of security than WEP.

Zoom lens - A zoom lens can be moved (zoomed) to enlarge the view of an object to show more detail.
## Index

### A
- Accessing the video server 8
- Action 22
- Action buttons 9, 20
- Active/Inactive 9
- Active/Inactive (output buttons) 20
- Administrators 12
- Advanced TCP/IP settings 39
- Alarm 22, 25, 46
- Allowed IP addresses 34
- AMC 10
- Anonymous viewing 34
- ARP/Ping 38
- Auxiliary power 46
- AXIS Internet Dynamic DNS Service 38

### B
- Backup 42
- Bandwidth 55
- Buffers 24

### C
- CGI links 20, 30
- Click-in-image 30
- Clients/viewers 11
- COM ports 47
- Connectors 45
- Control button 6, 44
- Customize 19

### D
- Date & time 37
- DC power 46
- Default Viewer 21
- Default viewer 21
- Digital input 46
- DIP switch 6
- DNS configuration 39
- DNS server 39
- Domain name 39
- D-Sub connector 45
- D-Sub connector 45

### E
- Emergency recovery 49
- Enable ARP/Ping 38
- Event 22
- Event servers 22
- Excluded widows 26
- External video 21
- External video sources 9

### F
- Factory default settings 44
- Frame rates 14, 55
- FTP server 22

### G
- Generic HTTP 47
- Generic TCP/IP 47

### H
- Host name 39
- HTML examples 21
- HTTP API 20, 30
- HTTP port number 39
- HTTP server 22
- HTTPS 35

### I
- I/O ports 42
- I/O terminal connector 7, 46
- Included windows 25
- Installing PTZ devices 27
- IP address filtering 34

### L
- Live view config 18
- Live View page 9, 12
- Logs & Reports 43

### M
- Motion detection 25
N
Network settings 37
NTP server 37

O
Operators 34
Output buttons 9, 20
Own home page 19
Own web files 19

P
Pan Tilt Zoom 47
Pan/Tilt/Zoom 29
Performance 54
Pinout 42
Pinout - I/O connectors 46
Port status 26
Post-trigger buffer 24
Power adapter 7
Preset positions 31
Pre-trigger buffer 24
PTZ 27
PTZ commands 20, 30
PTZ control queue 32
Pulse 9
Pulse (outputs) 20

Q
QoS 40
Quad stream 9

R
Recovery 49
Referrals 34
Relative and absolute PTZ drivers 29
Restart 42
Restore 42
RS-232 serial connector 7
RS-485 46
RTSP 40

S
Scheduled event 22, 24
Security 34
Sequence mode 9, 21
Serial number 7
Snapshot button 9
Source list 9
Support 43
System options 34

T
TCP server 22
TCP/IP Settings 37
Time mode 37
Transistor output 46
Triggered event 22, 23
Troubleshooting 48

U
Upgrade server 42
User defined links 20
Users 34

V
Video inputs 6
Video sources 14
Video streams 10, 14, 15
Viewer settings 21
Viewing clients 11